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          Adobe Acrobat Reader 
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To find a word using the Find command:

1. Click the Find button (Binoculars), or choose Edit > Find.

2. Enter the text to find in the text box.

3. Select search options if necessary:

Match Whole Word Only finds only occurrences of the complete word you enter in the box.  For example, if you search for the word stick, the words tick and sticky will not be highlighted.

Match Case finds only words that contain exactly the same capitalization you enter in the box.

Find Backwards starts the search from the current page and goes backwards through the document.

4. Click Find.  Acrobat Reader finds the next occurrence of the word.

To find the next occurrence of the word, Do one of the following:

            Choose Edit > Find Again 

            Reopen the find dialog box, and click Find Again. 
            (The word must already be in the Find text box.)

Copying and pasting text and graphics to another application

You can select text or a graphic in a PDF document, copy it to the Clipboard, and paste it into another application such as a word processor.  You can also paste text into a PDF document note or into a bookmark.  Once the selected text or graphic is on the Clipboard, you can switch to another application and paste it into another document.  

Note:  If a font copied from a PDF document is not available on the system displaying the copied text, the font cannot be preserved.  A default font  is substituted.

To select and copy it to the clipboard:

1. Select the text tool T, and do one of the following:

       To select a line of text, select the first letter of the sentence or phrase and drag to
       the last letter.  

To select multiple columns of text (horizontally), hold down Ctrl+Alt (Windows) or Option (Mac OS) as you drag across the width of the document. 

To select a column of text (vertically), Hold down Ctrl+Alt (Windows) or Option+Command (Mac OS) as you drag the length of the document.

To  select all the text on the page, choose Edit > Select All.  In single page mode, all the text on the current page is selected.  In Continuous or Continuous – facing mode, most of the text in the document is selected.  When you release the mouse button, the selected text is highlighted.  To deselect the text and start over, click anywhere outside the selected text.  

The Select All command will not select all the text in the document.  A workaround for this (Windows) is to use the Edit > Copy command.  Choose Edit > Copy to copy the selected text to the clipboard.

2. To view the text, choose Window > Show Clipboard

In Windows 95, the Clipboard Viewer is not installed by default and you cannot use the Show Clipboard command until it is installed.  To install the Clipboard Viewer, Choose Start > Settings > Control Panel > Add/Remove Programs, and then click the Windows Setup tab.  Double-click Accessories, check Clipboard Viewer, and click OK.

[There was no reportable action as a result of the

Board of Supervisors' closed session held today.]

SUP. MOLINA: GOOD MORNING, WE ARE GOING TO BEGIN THIS MORNING. THIS MORNING WE ARE GOING TO BE LED IN OUR INVOCATION BY PASTOR ERIC TIETZE AS WELL AS OUR PLEDGE OF ALLEGIANCE THIS MORNING BY HERBERT GARCIA. CAN I ASK YOU ALL TO PLEASE STAND? 

PASTOR ERIC TIETZE: FATHER, WE THANK YOU FOR THIS MORNING, LORD, WE HONOR YOU TODAY AND WE INVITE YOUR HOLY SPIRIT TO BE HERE, FATHER. WE PRAY, FATHER, FOR THE SUPERVISORS. AND LORD, WE ASK THAT YOU GIVE THEM THE WISDOM. FATHER, CONTINUE, FATHER, TO MINISTER. AND LORD, FATHER, THAT YOUR COMPASSION WOULD BE, FATHER, IN THIS CITY FOR THOSE THAT ARE LESS FORTUNATE. AND LORD FATHER, WE JUST PRAY A BLESSING UPON THIS CITY, UPON THESE SUPERVISORS, LORD. WE ASK YOU TO CONTINUE, FATHER, TO OPEN UP DOORS AND THAT YOUR FAVOR WOULD BE HERE. FATHER, LET THE REVELATION OF WHO YOU ARE CONTINUE TO MOVE, LORD, THROUGH THIS PLACE. AND LORD, CONTINUE, FATHER, TO LEAD THEM AND GUIDE THEM AND DIRECT THEM BY YOUR SPIRIT. FATHER, WE THANK YOU FOR TODAY. WE'RE HONORED TO BE HERE, LORD. AND WE ASK YOU TO BLESS EVERY PERSON THAT COMES INTO THIS PLACE. AND WE PRAY ALL OF THIS IN THE NAME OF THE FATHER, YOUR SON, THE HOLY SPIRIT, AMEN. 

HERBERT J. GARCIA: IF YOU WILL PLEASE FACE THE FLAG AND PLACE YOUR HAND OVER YOUR HEART, TO BEGIN THE PLEDGE OF ALLEGIANCE. [PLEDGE OF ALLEGIANCE RECITED.] 

SUP. MOLINA: PLEASE JOIN ME HERE. THIS MORNING WE WERE LED IN OUR INVOCATION BY PASTOR ERIC TIETZE. PASTOR TIETZE IS THE DIRECTOR OF A PROGRAM CALLED "HEART OF COMPASSION." IT IS SITED IN MONTEBELLO. IT IS A NONPROFIT FOOD BANK AND A RESOURCE CENTER THAT SERVES THE GREATER LOS ANGELES REGION. EACH WEEK THE ORGANIZATION DISTRIBUTES OVER 80,000 POUNDS OF FOOD AND GENERAL MERCHANDISE TO CHURCHES, TO CHARITIES AND OTHER WORTHY COMMUNITY-BASED ORGANIZATIONS WHO, IN TURN, FULFILL THEIR MISSION TO FEED THE HUNGRY AS WELL AS THE POOR. PASTOR TIETZE IS A DEDICATED COLLEAGUE AND HIS VOLUNTEERS ARE TRULY COMMITTED TO THEIR MISSION TO HELP THOSE IN NEED. THIS MORNING, HE PRESENTED ME WITH A WHOLE NOTEBOOK OF ALL THE COMMENDATIONS, ALL OF THE WORK, ALL OF THE PICTURES OF THE GREAT WORK THAT THEY DO EVERY SINGLE DAY IN THE COMMUNITY. THEIR ONGOING EFFORTS HAVE TOUCHED COUNTLESS LIVES THROUGHOUT L.A. COUNTY. WE WANT TO COMMEND HIM AND THANK HIM FOR JOINING US TODAY AND LEADING US IN OUR INVOCATION. THANK YOU, SIR, CONGRATULATIONS. [APPLAUSE.] ON BEHALF OF SUPERVISOR ANTONOVICH, I'M VERY HONORED TO MAKE A PRESENTATION THIS MORNING OF A CERTIFICATE OF APPRECIATION TO HERBERT GARCIA. TODAY, HERBERT GARCIA OF PASADENA LED US IN OUR PLEDGE OF ALLEGIANCE. HE HAS SERVED AS SEAMAN FIRST CLASS IN THE UNITED STATES NAVY FROM 1942 TO 1946 IN THE SOUTH PACIFIC. HE HAS BROUGHT A LIST, WHICH I WAS IMPRESSED WITH, THIS IS THE SHIP THAT YOU SERVED ON? 

HERBERT GARCIA: YES, MA'AM. 

SUP. MOLINA: THE U.S.S.S.M. HAS ALL OF THE LISTINGS AND WHO IT WAS COMMANDED BY, ALL OF THE CAMPAIGN RIBBONS, OF WHICH THERE ARE SIX. ALL OF THE 8-STAR ENGAGEMENTS THAT YOU HAD. INVOLVED IN WORLD WAR II. JUST AMAZING. AND A WHOLE SUMMARY OF ALL OF THE ACTIONS THAT WE'RE TAKING. I THOUGHT IT WAS SO IMPRESSIVE THAT WHILE YOU WERE THERE, HE SUNK THREE SHIPS. HE DESTROYED SIX MINES. AND THE MILES THAT WERE SEEN 163,842.8 MILES. AMAZING. ANYWAY, IT IS SUCH AN HONOR TO HAVE YOU HERE THIS MORNING AND PRESENT YOU ON BEHALF OF THE BOARD AND SUPERVISOR ANTONOVICH THIS CERTIFICATE OF APPRECIATION. CONGRATULATIONS, MR. GARCIA. THANK YOU SO MUCH. [APPLAUSE.] THANK YOU. LET ME SHARE THIS BACK WITH YOU. I DON'T WANT TO TAKE IT FROM YOU. THANK YOU SO MUCH. SUPERVISOR MARK RIDLEY-THOMAS. ALL RIGHT. AT THIS POINT I'M GOING TO ASK OUR EXECUTIVE OFFICER TO PLEASE CALL THE AGENDA. 

DON ASHTON: GOOD MORNING MADAME CHAIR PRO TEM AND MEMBERS OF THE BOARD. WE WILL BEGIN ON PAGE 3. MEETING OF THE COMMUNITY DEVELOPMENT COMMISSION ITEM 1-D. WE HAVE A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. 

SUP. MOLINA: ALL RIGHT. WE WILL HOLD THAT ITEM. 

DON ASHTON: PUBLIC HEARING ITEMS NO.S 1-11. ON ITEMS NO. 8 AND 9, SUPERVISOR KNABE ASKS THAT THESE BE CONTINUED TWO WEEKS WITHOUT DISCUSSION TO AUGUST 11TH, 2009. THE REMAINING PUBLIC HEARING ITEMS WILL BE HELD FOR THE PUBLIC HEARING. 

SUP. MOLINA: WITH THE EXCEPTION OF 8 AND 9 THAT ARE CONTINUED, THE ITEMS ARE MOVED BY SUPERVISOR RIDLEY-THOMAS, SECONDED BY SUPERVISOR YAROSLAVSKY. IF THERE'S NO OBJECTION, SO ORDERED ON THOSE ITEMS. 

SUP. YAROSLAVSKY: EXCUSE ME. DID WE JUST APPROVE ALL OF THE--? 

DON ASHTON: WITH THE EXCEPTION OF 8 AND 9, WE NEED TO HOLD 1 THROUGH 11 FOR THE PUBLIC HEARING. 

SUP. MOLINA: THANK YOU FOR THAT CORRECTION. 

DON ASHTON: WE ARE NOW ON PAGE 7. BOARD OF SUPERVISORS ITEMS 12 THROUGH 15. ALL OF THOSE ITEMS ARE BEFORE YOU. 

SUP. MOLINA: OKAY. THERE'S NO HOLDS ON THOSE ITEMS. MOVED BY SUPERVISOR YAROSLAVSKY. SECONDED BY SUPERVISOR RIDLEY-THOMAS. NO OBJECTIONS, SO ORDERED. 

DON ASHTON: THE CONSENT CALENDAR, ITEMS NO.S 16 AND 17. BOTH OF THOSE ITEMS ARE BEFORE YOU. 

SUP. MOLINA: ALL RIGHT. ON THOSE ITEMS, MOVED BY SUPERVISOR RIDLEY-THOMAS, SECONDED BY SUPERVISOR YAROSLAVSKY. IF THERE'S NO OBJECTION, SO ORDERED. 

DON ASHTON: ON PAGE 9, DISCUSSION ITEMS. AS INDICATED ON THE SUPPLEMENTAL AGENDA, ON ITEM NO. 18, THE CHIEF EXECUTIVE OFFICER REQUESTS THAT THIS ITEM BE REFERRED BACK TO HIS OFFICE. AND ITEM 19 WILL BE HELD FOR DISCUSSION. 

SUP. MOLINA: OKAY. 

DON ASHTON: AND THAT COMPLETES THE READING OF THE AGENDA. BOARD OF SUPERVISORS SPECIAL ITEMS BEGIN WITH SUPERVISORIAL DISTRICT NO. 1. 

SUP. MOLINA: VERY GOOD. THANK YOU SO MUCH. SHORT AGENDA. LET'S MOVE ON TO PRESENTATIONS. I WOULD LIKE TO INVITE THE HONORABLE PAULINA KAPUSCINSKA. WELCOME. GOOD MORNING, THIS IS THE CONSUL GENERAL OF POLAND, TO THE DAIS. CONSUL GENERAL KAPUSCINSKA EARNED A MASTER'S DEGREE IN ECONOMICS AND GEOGRAPHY FROM THE WARSAW UNIVERSITY AND BECAME A JOURNALIST AND GOVERNMENT SPOKESPERSON. SHE WORKED FOR THE PRIME MINISTER, EARNED A DEGREE FROM THE WARSAW UNIVERSITY OF NATIONAL DEFENSE. THEN BECAME THE PRESS OFFICER TO THE CHIEF NEGOTIATOR FOR THE POLISH MINISTRY OF FOREIGN AFFAIRS. SHE ALSO EARNED A DIPLOMA IN EUROPEAN UNION AFFAIRS FROM THE PRESTIGIOUS FRENCH NATIONAL SCHOOL OF ADMINISTRATION. BEFORE BEING APPOINTED TO HER POST IN JANUARY OF 2008, SHE SERVED IN LOS ANGELES AS THE CONSUL FOR CULTURE, EDUCATION, PRESS AS WELL AS POLISH AFFAIRS. DURING HER TENURE, THE CONSUL GENERAL WAS RESPONSIBLE FOR 15 WESTERN STATES INCLUDING HAWAII AND ALASKA. SHE PROMOTED COLLABORATION AMONG POLES, AMERICANS AND JEWS AND FACILITATED A MISSION OF 100 JEWISH CANTORS TO POLAND. SHE'S ALSO BEEN ACTIVE, AS WELL AS A LOBBYIST FOR THE SISTER CITY RELATIONSHIP BETWEEN THE CITY OF LOS ANGELES AND THE POLISH CITY OF LODZ. ON BEHALF OF THE 10 MILLION PEOPLE HERE IN LOS ANGELES COUNTY, WE ARE VERY PROUD OF YOUR SERVICE, AND THANK YOU SO MUCH FOR JOINING US THIS MORNING, AND CONGRATULATIONS TO YOU, AND GOOD LUCK ON YOUR FUTURE CAREER. THANK YOU. 

HON. PAULINA KAPUSCINKSA: THANK YOU VERY MUCH, MADAME. [APPLAUSE.] 

SUP. MOLINA: WOULD YOU SHARE A FEW WORDS? 

HON. PAULINA KAPUSCINSKA: THANK YOU VERY MUCH. MADAME, THANK YOU VERY MUCH, LADIES AND GENTLEMEN. THIS IS MY PRIVILEGE TO BE THIS MORNING WITH YOU. I'M VERY PROUD OF THIS FLAG. VERY BRIEFLY, I WOULD LIKE TO TELL YOU THAT WORKING AND LIVING IN LOS ANGELES, THE COUNTY OF LOS ANGELES, ACTUALLY I HAVE BEEN LIVING IN SANTA MONICA, AND WORKING IN THE CITY OF LOS ANGELES, WAS A WONDERFUL JOURNEY, AMAZING EXPERIENCE. I TRULY APPRECIATE WORKING WITH MY AMERICAN PARTNERS. AND I KNOW THAT I'M LEAVING THE POLISH COMMUNITY IN GOOD HANDS AND IN REALLY GREAT SHAPE IN LOS ANGELES. AND I'M SURE THAT WE CAN DEVELOP SOME FUTURE COLLABORATION BETWEEN THE COMMUNITY OF POLISH COMMUNITY IN LOS ANGELES, POLAND AND AMERICA AND COUNTY OF LOS ANGELES. I WILL MISS YOU. THANK YOU VERY MUCH. [APPLAUSE.] 

SUP. MOLINA: I HAVE ANOTHER PRESENTATION. AND THIS ONE I AM VERY, VERY PROUD OF. I'M GOING TO ASK A WHOLE GROUP OF PEOPLE TO COME UP AND JOIN US US. [APPLAUSE.] NOW, THIS IS THE BAG MONSTER. [LAUGHTER.] HE'S BEEN SITTING THERE PATIENTLY WAITING. WE WANTED TO SHOW YOU THE BAG MONSTER IS A DEPICTION OF HOW MANY BAGS EACH OF US USE IN A YEAR. AND IT IS DESTRUCTIVE, AS ALL THE KIDS LEARNED IN SCHOOL, TO OUR ENVIRONMENT. IT IS DESTRUCTIVE TO ALL OF US. AND WE ARE TRYING TO FIND WAYS TO COMBAT THE USE OF PLASTIC BAGS THROUGHOUT L.A. COUNTY. ONE DAY WE WILL GET IT OUT OF THE BOWELS OF THE C.A.O.'S OFFICE AND HAVE A COUNTY-WIDE POLICY IN THIS AREA. BUT IN THE MEANTIME, ONE OF THE THINGS THAT WE DID, THROUGH THE HELP OF MY STAFF IN THE FIRST DISTRICT, IS WE CREATED A VERY, VERY SPECIAL PROGRAM. I WAS VERY PROUD OF PUBLIC WORKS AND THE WORKS THAT THEY DID IN BUILDING A CURRICULUM AND HAVING A PROGRAM. AND I ENCOURAGE ALL MY COLLEAGUES TO DO SOMETHING SIMILAR WITHIN THEIR DISTRICT. IT WAS FASCINATING ABOUT ALL OF THE ENTIRE PROJECT IS HOW QUICKLY EVERYBODY JOINED UP IN THE EFFORT. THE SPONSORS WERE UNBELIEVABLE. ONE AFTER ANOTHER, THEY CAME ON, JOINED UP, HELPED US RAISE THE DOLLARS. WE WERE ABLE TO GIVE EACH OF THESE CHILDREN ONE OF THESE BAGS THAT BASICALLY IS THEIR SHOPPING BAG. AND IT WAS A SPECIAL PROGRAM. WE CREATED AN INCENTIVE. WE INVITED THE SCHOOLS TO JOIN US. WE'RE CARRYING OUT THIS PROGRAM THROUGH MOST OF OUR SCHOOLS. WE'RE DOING THEM A PERIOD OF TIME. AND IT INCLUDES A CURRICULUM. SO THAT THE CHILDREN ARE LEARNING ABOUT WHAT KIND OF DESTRUCTION THESE PLASTIC BAGS CREATE IN OUR ENVIRONMENT EVERY SINGLE DAY. WITH THE IDEA THAT THEY TAKE HOME THEIR LESSONS AND THEY TEACH THE ENTIRE FAMILY ABOUT THE KIND OF DESTRUCTIVE EFFORTS THAT PLASTIC BAGS CAN CAUSE IN OUR ENVIRONMENT. WHAT WE DID IS WE HAD A VERY, VERY UNIQUE AND SPECIAL CONTEST THAT WE PUT TOGETHER. WE CREATED SOME INCENTIVES FOR THE KIDS. AND THE STORES PARTICIPATED WITH US. EVERY TIME THEY AND THEIR FAMILY WOULD GO INTO ONE OF THE MARKETS THAT PARTICIPATED WITH US, THEY RECEIVED A SPECIAL STICKER. AND THESE STICKERS EVENTUALLY FILLED UP A CARD AND THEN WE HAD CHAMPIONS AND WINNERS THROUGHOUT THE SCHOOL AS WELL AS A WHOLE SCHOOL THAT WON. AND THEY ALL GET THESE WONDERFUL PRIZES THAT MANY OF OUR SPONSORS WERE INVOLVED IN. AND SO WHAT I'M VERY PROUD OF IS THAT ALL OF THIS HAPPENED. IT CONCLUDED ON EARTH DAY ON APRIL THE 22ND. DURING THAT TIME, 4,000 PLASTIC BAGS WERE NOT UTILIZED IN THE FIRST DISTRICT. AND WE WERE GRATIFIED TO BRING A WHOLE LEVEL OF AWARENESS TO MANY OF THE YOUNG PEOPLE IN OUR COMMUNITY FOR THE ELEMENTARY SCHOOLS THAT PARTICIPATED. AND TODAY WE ACKNOWLEDGE, OF COURSE, LILLIAN ELEMENTARY SCHOOL. THEY HAD THE HIGHEST NUMBER OF EARTH DEFENDERS IN THEIR SCHOOL. AND WE'RE VERY PROUD OF THEM. [APPLAUSE.] SO, I'D LIKE TO BEGIN, AS I PUSH OVER MY OWN PLASTIC BAG HERE, I'D LIKE TO BEGIN BY CONGRATULATING OUR TOP EARTH DEFENDERS. FIRST OF ALL, WE HAVE DYLAN MIORGA. HIS FAMILY USED THIS BAG, THE REUSABLE BAG, 262 TIMES. AND SO I WANT TO GIVE HIM A CERTIFICATE OF APPRECIATION FOR HIS OUTSTANDING WORK. [APPLAUSE.] WE ARE OVER HERE. WE WILL TAKE A PICTURE. LOOK AT HIM. THERE WE GO. HERE'S YOUR CERTIFICATE. GOT ALL KIND OF GOODIES THAT HE WON IN HIS BAG, AS WELL, WHICH WERE WONDERFUL. NEXT WE HAVE ROGELIO VIERA. AND ROGELIO'S FAMILY USED THEIR BAG 193 TIMES. CONGRATULATIONS. [APPLAUSE.] AND WE HAVE CARLA SANCHEZ, AND HER FAMILY USED THEIR BAGS 103 TIMES. CONGRATULATIONS. [APPLAUSE.] CONGRATULATIONS, CARLA. NOW, I THINK THAT THIS IS THE TEAM THAT'S GOING WITH US TO A DODGER GAME, IS THAT RIGHT? YEAH! [LAUGHTER.] THE DODGERS WERE WONDERFUL IN GIVING US TICKETS SO THAT THEY COULD ATTEND A GAME. AND THERE'S BIKES THAT THEY RECEIVED. THEY HAD ALL KINDS OF-- WHO GOT THE BIKE? OOH, YOU GOT THE BIKE? CONGRATULATIONS. ANYWAY, WE CREATE THESE KIND OF INCENTIVES BECAUSE WE REALLY WANT TO HAVE A CHANGE IN THE ATTITUDE AND THE CULTURE AND CERTAINLY CREATE AN ENVIRONMENT THAT'S CLEANER, BETTER AND STRONGER EVERY SINGLE DAY. NONE OF THIS COULD HAVE HAPPENED WITHOUT THE SUPPORT OF THE SCHOOL. THE SCHOOL WELCOMED US. THEY INCORPORATED, THE TEACHERS WERE PART OF THE CURRICULUM. THEY DID AN OUTSTANDING JOB. WE SPENT ONE MORNING THERE. AND WE HAD A TERRIFIC TIME. AND I WANT TO THANK LILLIAN ELEMENTARY SCHOOL. AND TODAY HERE REPRESENTING THE SCHOOL IS MARIA ORTIZ, IF SHE'D COME UP? THANK YOU SO MUCH. [APPLAUSE.] SHE'LL TAKE THAT PROUDLY BACK. GREAT. THANK YOU. ALL RIGHT. WELL, AS I SAY, IN ORDER FOR THE MARKETS TO DO THIS, THEY HAD TO GO OUT OF THEIR WAY. THEY HAD TO TRAIN ALL OF THEIR CHECKERS ABOUT THEIR PROGRAM AND WHAT WAS GOING ON. THEY HAD LITTLE CARDS WITH THEM. AND THE KIDS OR THE PARENTS WOULD PRESENT THESE CARDS. AND THEY HAD TO BE GIVEN A STICKER. AND THEY STEPPED UP. AND I WAS SO VERY PROUD OF THEM. AND THEY JOINED US IN EVERY PART OF IT. LET ME THANK EL SUPERMARKET. WHICH IS ONE OF THE STORES IN OUR COMMUNITY. AND REPRESENTING THEM TODAY IS GABRIELLA VILA? [APPLAUSE.] THEY DID AN OUTSTANDING JOB. CONGRATULATIONS. 

GABRIELLA VILA: THANK YOU SO MUCH. 

SUP. MOLINA: THANK YOU. ALSO JOINING US WAS EL TAPATIO MARKET. AND LARRY FUERES COULDN'T MAKE IT TODAY. BUT WE WANT TO THANK THEM ANYWAY. THE OTHER MARKET THAT WAS WONDERFUL AND PARTICIPATED WAS A SUPERIOR GROCERS. AND THEY TODAY ARE REPRESENTED BY VALERIE BAILEY. [APPLAUSE.] THANK YOU SO MUCH. THANK EVERYBODY FOR US, WOULD YOU? INSTRUMENTAL IN THIS IS AN ORGANIZATION AND NONPROFIT THAT HAS BEEN SO HELPFUL. THEY WERE ALSO A BIG PART OF DESIGNING THE PROGRAM AND WORKING IN CONCERT WITH US. AND I WANT TO THANK THEM. THEY HAVE BEEN DOING OUTSTANDING WORK IN OUR COMMUNITY AND PROTECTING AND PRESERVING OUR ENVIRONMENT AND CONSERVING AND REALLY MAINTAINING A GREEN SPACE EVERYWHERE. I WANT TO THANK THE SAN GABRIEL VALLEY CONSERVATION CORPS TODAY THEY'RE REPRESENTED BY CANDICE CRUISE. 

ANDREW QUINENES: ANDREW QUINENES. 

SUP. MOLINA: I'M SORRY, I HAVE THE WRONG NAME. I APOLOGIZE. THANK YOU. THERE WE GO. CONGRATULATIONS, SIR. ONE MORE? ALONG THE WAY, WE HAD UNBELIEVABLE SPONSORS. THEY STEPPED UP. THEY WERE A PART OF IT. THEY ATTENDED THE ASSEMBLY WITH US. THEY ENCOURAGED MANY OF THE KIDS. AND ALSO WERE PART OF CREATING LITTLE PRIZES. AND THE KIDS WERE VERY, VERY RECEPTIVE, TOO. I WANT TO THANK STEVEN GRACIANO FROM FOX NEWS EN ESPANOL. THANK YOU SO MUCH. [APPLAUSE.] ALSO WE OF COURSE HAD THE LOS ANGELES DODGERS. WE'RE ON OUR WAY TO A GAME THERE VERY SOON. AND TODAY REPRESENTING THE DODGERS IS NOEL PALAS? CONGRATULATIONS. [APPLAUSE.] THANK YOU. JOINING US, AS WELL, IS ONE OF OUR OTHER SPONSORS THAT DOES GREAT WORK IN THE COMMUNITY AND IN THE ENVIRONMENT AND REPRESENTING HEAL THE BAY TODAY IS SONYA DIAZ. SONYA? [APPLAUSE.] AS I SAID, OUR DEPARTMENT OF PUBLIC WORKS WAS REALLY INSTRUMENTAL. THEY DID A GOOD JOB AND THEY WERE PART OF IT AND THEY'VE BEEN A GREAT PART OF THE PROGRAM. AND I REALLY ENCOURAGE MY COLLEAGUES TO UTILIZE THEIR CURRICULUM AND THEIR PROGRAM FOR THE SCHOOLS WITHIN THEIR DISTRICT. I THINK IT GOES A LONG WAY. AND I WANT TO THANK THE DEPARTMENT FOR THE WORK THAT THEY DID. AND REPRESENTING THEM TODAY IS EMILIO THOMPSON. [APPLAUSE.] THEY HAD A GREAT SKIT THAT THEY PRESENTED AT OUR ASSEMBLY, AND WE REALLY APPRECIATED THE WORK THAT THEY DID OUT THERE. REPRESENTING THE SOUTHERN CALIFORNIA GAS COMPANY WHICH IS A GREAT SPONSOR AND JOINED US VERY QUICKLY WAS ANDY CARASCO AND MICHAEL DE LA TORRES. THANK YOU, GENTLEMEN, GREAT JOB. [APPLAUSE.] ANOTHER GREAT SPONSOR, OF COURSE, WAS SOUTHERN CALIFORNIA EDISON, AND TODAY IS REPRESENTED BY WESLEY TANAKA. MR. TANAKA, THANK YOU SO MUCH. PLEASE THANK EVERYBODY FOR US. [APPLAUSE.] A.T.&T. WAS ALSO ONE OF OUR SPONSORS. AND TODAY THEY ARE REPRESENTED BY DAN RIVETO? DAN? THANK YOU. GOOD TO SEE YOU. [APPLAUSE.] AND FINALLY WE WERE ABLE TO GET WONDERFUL PRODUCTS AND ALL KINDS OF OTHER SPONSORSHIP GIFTS THAT WERE TERRIFIC FROM THE WALT DISNEY COMPANY. AND TODAY REPRESENTED, I SAW MURRAY EPHRON ________ JOINING US. THANK YOU SO MUCH, CONGRATULATIONS, AND THANK YOU. THANK ALL THE COMPANY FOR US. [APPLAUSE.] THANK YOU. I REALLY HOPE THAT YOU UNDERSTAND THAT THESE ARE THE KINDS OF EFFORTS THAT NEED TO BE UNDERTAKEN. EVENTUALLY WE'RE GOING TO GET CONTROL OF THESE HORRIBLE PLASTIC BAGS IN OUR ENVIRONMENT. BUT LITTLE BY LITTLE ALL OF US ARE LEARNING TO USE OUR RECYCLABLE AND REUSABLE BAGS ON AN ONGOING BASIS. BUT THE BEST THING THAT COULD HAPPEN IS FOR THESE CHILDREN TO LEARN A LIFELONG LESSON. AND I WANT TO THANK MY STAFF, ERICA, AND MY FIELD STAFF DID AN OUTSTANDING JOB. I THANK THEM. CONGRATULATIONS. [APPLAUSE.] I WANT TO THANK ALL OF OUR SPONSORS. WITHOUT THEM, WE COULDN'T HAVE DONE IT. AND I REALLY WANT TO THANK THE SCHOOL AND THE KIDS. I HOPE IT WILL BE A LIFELONG LESSON THAT THEY'RE GOING TO TEACH THEIR CHILDREN AND THEIR FRIENDS ALL OF THE TIME, THAT EVENTUALLY WE'RE GOING TO GET RID OF THIS UGLY MONSTER, THAT WE WILL NOT HAVE CARRYING AROUND WITH US, THAT EACH OF US USE THAT MANY BAGS IN ONE YEAR. SO CONGRATULATIONS TO ALL OF US. WOULD YOU PLEASE APPLAUD THEM ALL? THEY'RE VERY DESERVING. CONGRATULATIONS. [APPLAUSE.] AGAIN, THANK YOU SO MUCH. MR. YAROSLAVSKY, YOU HAVE PRESENTATIONS? 

SUP. YAROSLAVSKY: THANK YOU, MADAME CHAIR. I HAVE ONE PRESENTATION. THAT'S TO STEVEN GOLIGHTLY, WILL YOU JOIN ME HERE? THERE HE IS. OKAY. I WANT TO TAKE THIS OPPORTUNITY THIS MORNING TO PROCLAIM CHILD AWARENESS MONTH FOR AUGUST 2009. AUGUST HAS BEEN DESIGNATED AS CHILD SUPPORT AWARENESS MONTH IN THE STATE OF CALIFORNIA TO EDUCATE AND INFORM THE PUBLIC ABOUT THE WORK OF THE LOS ANGELES COUNTY CHILD SUPPORT SERVICES DEPARTMENT AND THE IMPORTANCE OF COLLECTIONS TO IMPROVE THE WELL-BEING OF CHILDREN AND THE SELF-SUFFICIENCY OF FAMILIES THROUGHOUT OUR COUNTY. C.S.S.D., THE CHILD SUPPORT SERVICES DEPARTMENT, IS THE LARGEST LOCAL L.A. ADMINISTERED CHILD SUPPORT AGENCY IN THE NATION MANAGING OVER 425,000 CASES, WHICH CONSTITUTE APPROXIMATELY 25 PERCENT OF THE TOTAL CASELOAD IN THE STATE OF CALIFORNIA AND EMPLOYING MORE THAN 1800 DEDICATED PROFESSIONALS, IT COLLECTED $517 MILLION IN CHILD SUPPORT LAST YEAR, WINNING RECOGNITION AS CALIFORNIA'S MOST IMPROVED COUNTY CHILD SUPPORT AGENCIES. C.S.S.D. HAS CONTINUED ITS ALREADY AMBITIOUS OUTREACH PROGRAM TO EDUCATE THE PUBLIC ABOUT ITS SERVICES, EXTENDING TO OVER 30,000 INDIVIDUALS EACH YEAR. IT HAS COLLABORATED AND PARTNERED WITH OTHER COMMUNITY ORGANIZATIONS, GOVERNMENT AGENCIES AND EDUCATIONAL INSTITUTIONS TO CONSISTENTLY IMPROVE SERVICE. SO THE BOARD OF SUPERVISORS WANTED TO RESOLVE THAT THE COUNTY OF LOS ANGELES RECOGNIZES AUGUST 2009 AS CHILD SUPPORT AWARENESS MONTH AND COMMENDS THE CHILD SUPPORT SERVICES DEPARTMENT FOR ITS COMMITMENT AND SUBSTANTIAL IMPACT TOWARDS IMPROVING THE QUALITY OF LIFE FOR CHILDREN AND FAMILIES. AND FOR THOSE OF US WHO REMEMBER THE DOG DAYS IN THIS DEPARTMENT SOME YEARS AGO, THE TOTAL TURNAROUND OF THIS DEPARTMENT TO REACH, REALLY THE PINNACLE OF ITS COLLEAGUES AND PEERS IN THIS FIELD IS REALLY A WONDERFUL THING. IT JUST GOES TO SHOW THE HARD WORK AND FOCUS AND A GOOD PLAN AND COMMITMENT TO EXCELLENCE CAN OVERCOME VIRTUALLY ANY OBSTACLE. SO, STEVE, I WANT TO PRESENT THIS TO YOU AND TO YOUR COLLEAGUES HERE ON BEHALF OF THE BOARD OF SUPERVISORS. CONGRATULATIONS. [APPLAUSE.] 

STEVEN GOLIGHTLY: THANK YOU, SUPERVISOR YAROSLAVSKY, AND ALL THE MEMBERS OF THE BOARD AND THE C.E.O. FOR YOUR CONTINUED SUPPORT OF OUR WORK TO HELP THOSE CHILDREN AND FAMILIES WHO COUNT ON US FOR HELP EVERY DAY. I AM SO PROUD TO BE A PART OF THIS INCREDIBLE GROUP OF INDIVIDUALS WHO CALL THEMSELVES CHILD SUPPORT PROFESSIONALS. I'D LIKE TO ACKNOWLEDGE MY MEMBERS OF MY SENIOR MANAGEMENT TEAM THAT ARE HERE THIS MORNING AND MEMBERS OF OUR MENTORSHIP PROGRAM. WOULD YOU PLEASE STAND AND BE ACKNOWLEDGED ALSO? [APPLAUSE.] THESE ARE PARTICULARLY TOUGH TIMES FOR THE CHILDREN AND FAMILIES WHO COME TO MY DEPARTMENT FOR HELP. BUT I WANT YOU TO KNOW, SUPERVISOR, THAT WE'RE GOING TO BE WORKING PARTICULARLY HARD THIS MONTH TO CONTINUE TO GET THE WORD OUT ABOUT OUR SERVICES. THANK YOU. 

SUP. YAROSLAVSKY: THANK YOU. [APPLAUSE.] 

C.E.O. FUJIOKA: SUPERVISOR, WOULD YOU MIND IF I MAKE A QUICK COMMENT, PLEASE? WE'RE SENDING A NOTICE OUT TO YOUR BOARD THAT WILL ACKNOWLEDGE AND, WITH THAT, RECOGNIZE THE WORK OF CHILD SUPPORT SERVICES STAFF BECAUSE FOR THE FIRST TIME IN THE HISTORY OF THIS COUNTY, THEY'VE EXCEEDED THE 50 PERCENT RATE. THAT IS AMAZING ACCOMPLISHMENT. [APPLAUSE.] AND WE KNOW THAT NOTHING OF THAT MAGNITUDE HAPPENS ACCIDENTALLY. IT'S THROUGH THE EXCEPTIONALLY HARD WORK OF THE WOMEN AND MEN IN CHILD SUPPORT SERVICES. AND WITH THAT, THE LEADERSHIP THAT STEVEN BRINGS. IT'S AN INCREDIBLE ACCOMPLISHMENT. 

SUP. MOLINA: CONGRATULATIONS. [APPLAUSE.] SUPERVISOR RIDLEY-THOMAS, DO YOU HAVE ANY PRESENTATIONS? 

SUP. RIDLEY-THOMAS: I DO NOT, MADAME CHAIR. 

SUP. MOLINA: ALL RIGHT. THEN I'M GOING TO ASK THE EXECUTIVE OFFICER TO MOVE FORWARD WITH THE HEARINGS TO SWEAR IN ALL OF THOSE WHO WILL TESTIFY. 

DON ASHTON: ON ITEMS NUMBERS 1 THROUGH 11, ALL THOSE WHO PLAN TO TESTIFY BEFORE THE BOARD, PLEASE STAND AND RAISE YOUR RIGHT HAND TO BE SWORN IN? IN THE TESTIMONY YOU MAY GIVE BEFORE THIS BOARD, DO YOU SOLEMNLY AFFIRM TO TELL THE TRUTH, THE WHOLE TRUTH AND NOTHING BUT THE TRUTH, SO HELP YOU GOD? THANK YOU. YOU MAY BE SEATED. ON ITEM NO. 1, LET ME READ THE SHORT TITLE IN FOR THE RECORD. THIS IS A HEARING ON FORMATION OF IMPROVEMENT ZONE 539 FOR PETITION NO. 91-805 (EDDERTON AVENUE) IN COUNTY LIGHTING MAINTENANCE DISTRICT 1687 AND COUNTY LIGHTING DISTRICT L.L.A.-1, UNINCORPORATED ZONE, LA MIRADA AREA IN FISCAL YEAR 2009-2010. THERE IS A DEPARTMENT STATEMENT AND NO CORRESPONDENCE WAS RECEIVED. 

SUP. MOLINA: DO WE HAVE A REPORT? 

DAVID STRINGER: MY NAME IS DAVID STRINGER AND I'M A SENIOR CIVIL ENGINEER FOR THE DEPARTMENT OF PUBLIC WORKS. I'M FAMILIAR WITH THESE PROCEEDINGS FOR THE FORMATION OF IMPROVEMENT ZONE 539, THE LOAN FROM THE COUNTY LIGHTING MAINTENANCE DISTRICT 1687 TO THE NEW IMPROVEMENT ZONE, AND THE LEVYING AND COLLECTION OF ASSESSMENTS FOR PETITION AREA 91-805 IN THE FOURTH DISTRICT TO REPAY THE LOAN. IN MY OPINION, THE PETITION AREA WILL BE BENEFITED BY THE FORMATION OF THE IMPROVEMENT ZONE AND THE SERVICES TO BE PROVIDED AND THE PROPOSED ASSESSMENTS HAVE BEEN SPREAD IN PROPORTION TO BENEFIT. THE BASE ANNUAL ASSESSMENT OF $5 PER PARCEL WILL NOT BE AFFECTED BY YOUR BOARD'S ACTION TODAY. THE SPECIAL IMPROVEMENT ZONE ASSESSMENT WILL BE APPROXIMATELY $220 PER YEAR PER PARCEL OVER A 10-YEAR PERIOD. IN THE EVENT THAT THERE ARE NO MAJORITY PROTESTS, WE ARE RECOMMENDING THAT YOUR BOARD ADOPT THE RECOMMENDATION TO FORM THE IMPROVEMENT ZONE, AUTHORIZE THE LOAN FROM THE COUNTY LIGHTING MAINTENANCE DISTRICT TO THE NEW IMPROVEMENT ZONE AND LEVY THE PROPOSED ASSESSMENT FOR THE PURPOSES OF REPAYING THIS LOAN. 

SUP. MOLINA: ALL RIGHT. IS THERE ANYBODY WHO WISHES TO TESTIFY ON THIS ITEM? NO ONE? WE GOT NO CARDS OR ANYTHING. ALL RIGHT. 

DON ASHTON: MADAME CHAIR AND MEMBERS OF THE BOARD, IF THERE ARE NO QUESTIONS, IT WOULD BE APPROPRIATE AT THIS TIME TO CLOSE THE HEARING, DIRECT THE TABULATION OF BALLOTS, AND TABLE THE ITEM UNTIL LATER THE MEETING FOR TABULATION RESULTS AND ACTION BY THE BOARD. 

SUP. MOLINA: I SO MOVE. AND IT'S SECONDED BY SUPERVISOR YAROSLAVSKY. SO IF THERE IS NO OBJECTION, SO ORDERED ON THAT ITEM. ITEM NO. 2? 

DON ASHTON: ITEM NO. 2, THIS IS A HEARING ON ANNEXATION OF TERRITORY, PETITION NO. 21-207 (FAIRGREEN AVENUE ET AL) TO COUNTY LIGHTING MAINTENANCE DISTRICT 1687 AND COUNTY LIGHTING DISTRICT L.L.A.-1, UNINCORPORATED ZONE, EAST ARCADIA AREA AND LEVYING OF ASSESSMENTS WITHIN THE ANNEXED TERRITORY FOR STREET LIGHTING PURPOSES FOR FISCAL YEAR 2009-2010. THERE IS A DEPARTMENTAL STATEMENT AND CORRESPONDENCE WAS RECEIVED. 

SUP. MOLINA: PLEASE. 

DAVID STRINGER: MY NAME IS DAVID STRINGER AND I'M A SENIOR CIVIL ENGINEER FOR THE DEPARTMENT OF PUBLIC WORKS. I AM FAMILIAR WITH THE PROCEEDINGS FOR THIS ANNEXATION TO LIGHTING MAINTENANCE DISTRICT 1687 AND THE COUNTY LIGHTING DISTRICT L.L.A.-1, UNINCORPORATED ZONE. AND THE LEVYING AND COLLECTION OF AN ASSESSMENT FOR THE TERRITORIES IDENTIFIED IN THE BOARD LETTER WHICH ARE LOCATED IN THE UNINCORPORATED COMMUNITY OF EAST ARCADIA. IN MY OPINION, THESE TERRITORIES WILL BE BENEFITED BY THE ANNEXATION AND THE SERVICES TO BE PROVIDED AND THE PROPOSED ASSESSMENT HAVE BEEN SPREAD IN ACCORDANCE TO THE BENEFIT. WE'RE ALSO RECOMMENDING THAT YOUR BOARD ACCEPT THE NEGOTIATED EXCHANGE OF PROPERTY TAX REVENUES FOR THE NONEXEMPT TAXING AGENCIES. THE CORRESPONDENCE THAT WAS MENTIONED WAS FROM ONE RESIDENT SIGNED BY 12 NEIGHBORS ON HEATHER HEIGHTS OBJECTING TO THE INSTALLATION OF THE WOOD POLES THAT ARE BEING PROPOSED. AS STATED, THEY WOULD PREFER CONCRETE POLES, AND WE WILL WORK WITH THOSE RESIDENTS TO ENSURE THAT THEIR CONCERNS ARE ADDRESSED BEFORE INSTALLING ANY STREETLIGHTS. 

SUP. MOLINA: VERY GOOD. ALL RIGHT. WE HAVE ONE PERSON THAT WISHES TO TESTIFY ON THIS ITEM. MR. SACHS? MR. SACHS? FORGET IT OR YES? OH. THIS IS ITEM NO. 2. WHAT DID HE SAY? 

SUP. YAROSLAVSKY: HE SAID HE DIDN'T WANT TO SPEAK ON 2. I MOVE IT. 

SUP. MOLINA: I THINK WE HAVE TO CLOSE THE PUBLIC HEARING ON THIS ITEM AND DIRECT THE TABULATION OF BALLOTS. AND WE'LL TABLE THIS ITEM UNTIL LATER IN THE MEETING. 

SUP. YAROSLAVSKY: SO MOVED. 

SUP. MOLINA: MOVED BY SUPERVISOR YAROSLAVSKY. SECONDED BY MYSELF. SO ORDERED ON THAT ITEM. 

DAVID STRINGER: THANK YOU VERY MUCH. 

SUP. MOLINA: ITEM NO. 3. 

DON ASHTON: THIS IS A HEARING ON CONFIRMATION OF FISCAL YEAR 2008-2009 WEED ABATEMENT CHARGES TO BE ASSESSMENT TO OWNERS OF UNIMPROVED PARCELS DECLARED TO BE A PUBLIC NUISANCE, DUE TO HAZARDOUS WEEDS, BRUSH AND RUBBISH, AND REQUIRED ABATEMENT ENFORCEMENT. THERE IS NO DEPARTMENTAL STATEMENT, AND NO CORRESPONDENCE WAS RECEIVED. AND THERE ARE NO SPEAKERS. 

SUP. MOLINA: AND THERE ARE NO SPEAKERS. ALL RIGHT. ON THIS ITEM, MOVED BY SUPERVISOR YAROSLAVSKY, SECONDED BY SUPERVISOR RIDLEY-THOMAS. IF THERE'S NO OBJECTION, SO ORDERED ON ITEM NO. 3. ITEM NO. 4? 

DON ASHTON: THIS IS A HEARING ON CONFIRMATION OF THE 2008-09 HAZARDOUS VEGETATION ABATEMENT COST, TO BE ASSESSED TO OWNERS OF IMPROVED PARCELS WHICH WERE DECLARED A SEASONAL RECURRENT PUBLIC NUISANCE, DUE TO EXCESSIVE HAZARDOUS BRUSH, DRY GRASS, WEEDS, COMBUSTIBLE GROWTH OR FLAMMABLE VEGETATION, INCLUDING NATIVE AND ORNAMENTAL VEGETATION, AND REQUIRED ABATEMENT ENFORCEMENT. THERE IS NO DEPARTMENTAL STATEMENT, NO CORRESPONDENCE WAS RECEIVED AND THERE ARE NO SPEAKERS. 

SUP. MOLINA: ON THIS ITEM, MOVED BY SUPERVISOR RIDLEY-THOMAS, SECONDED BY SUPERVISOR YAROSLAVSKY. IF THERE'S NO OBJECTION, SO ORDERED ON THIS ITEM. ITEM NO. 5. 

DON ASHTON: THIS IS A HEARING ON ANNUAL SOLID WASTE GENERATION SERVICE CHARGE REPORT FOR FISCAL YEAR 2009-2010. THERE IS A DEPARTMENTAL STATEMENT. NO CORRESPONDENCE WAS RECEIVED AND THERE IS ONE SPEAKER. 

SUP. MOLINA: ALL RIGHT. 

KOBE SKY: GOOD MORNING, CHAIR AND SUPERVISORS. MY NAME IS KOBE SKY AND I'M A CIVIL ENGINEER WITH THE DEPARTMENT OF PUBLIC WORKS. I'M FAMILIAR WITH THESE PROCEEDINGS FOR THE CONTINUED COLLECTION OF THE SOLID WASTE GENERATION SERVICE CHARGE AT ITS CURRENT LEVEL ON THE TAX ROLL FOR FISCAL YEAR 2009-2010. THE ANNUAL REPORT ON THE SOLID WASTE GENERATION SERVICE CHARGE WAS PREPARED IN MY OFFICE AND UNDER MY DIRECTION. IN MY OPINION, IT IS NECESSARY TO RETURN THIS SERVICE CHARGE AT ITS CURRENT LEVEL. AND IT IS IN THE PUBLIC INTEREST TO CONTINUE TO COLLECT THE SERVICE CHARGE ON THE TAX ROLL BECAUSE IT PROVIDES FOR THE MOST ORDERLY COLLECTION OF SUCH CHARGE FROM THE AFFECTED PROPERTY OWNERS. IN MY OPINION, THE SERVICE CHARGE CONTINUES TO BE FAIRLY IMPOSED. AND WE HAVE NOT RECEIVED ANY PROTESTS TO THE REPORT. THANK YOU. 

SUP. MOLINA: ALL RIGHT. AND WE HAVE ONE SPEAKER ON THIS ITEM. MR. SACHS, IF YOU'D JOIN US? 

ARNOLD SACHS: THANK YOU, GOOD MORNING. THIS IS HEADING TOWARDS SOLID WASTE AND FEES CHARGED. AND IN A ROUNDABOUT WAY, THEY BRING ME BACK TO SUNSHINE CANYON LANDFILL AND THE FEES CHARGED AND COLLECTED THERE. HOW CAN YOU HONESTLY PUT SOME KIND OF FEES TOGETHER FOR A SOLID WASTE GENERATING SERVICE CHARGE WHEN YOU CAN'T GET THE MATH RIGHT FOR THE SOLID WASTE OR THE TRASH DISPOSED AT THE SUNSHINE CANYON LANDFILL? YOU APPRECIATED THE FACT THAT THE MATH WAS WRONG, THAT THE INCREASE, THE WASTE IMPACT OR THE WASTE INTAKE AT THE SUNSHINE CANYON LANDFILL WAS DOUBLED. THERE IS A FEE COLLECTED ON THAT FROM 6,000 TO 12,100 TONS. BUT ON A WEEKLY BASIS, IT WENT FROM 36,000 TO 66,000 TONS. WHERE IS THE MISSING 6,600 TONS OF WASTE AND THE MONEY THAT'S COLLECTED ON THAT? IT'S GOING SOMEWHERE. IT'S ON A REPORT SOMEPLACE. IT MAY NOT BE IN THIS COUNTY. BUT IT MAY BE IN SACRAMENTO. IT MAY BE IN WASHINGTON. HOW CAN YOU SIT AND PUT THIS STUFF THROUGH AND ACT LIKE "OH, NO BIG DEAL?" WHEN YOU CAN'T-- THERE WAS AN ARTICLE AND THERE WAS A STORY IN THE L.A. TIMES REGARDING THE BOARD OF EDUCATION. SOMEBODY ASKED FOR A RECIPE FOR SOME COFFEE CAKE. AND THEY GOT THE RECIPE WRONG. AND WHEN YOU CAN'T GET THE FIRST STEPS OF THE RECIPE RIGHT, HOW CAN YOU MOVE UP AND GRADUATE AND HOW CAN PEOPLE TAKE YOUR RESPONSES AND YOUR ACTIONS SERIOUSLY WHEN YOU REFUSE TO ANSWER THE GAPING QUESTIONS THAT ARE RIGHT IN FRONT OF YOU? THANK YOU. 

SUP. MOLINA: THANK YOU SO MUCH. ALL RIGHT. WITH THAT, ON ITEM 5, MOVED BY SUPERVISOR RIDLEY-THOMAS. SECONDED BY SUPERVISOR YAROSLAVSKY. IF THERE IS NO OBJECTION, SO ORDERED. ITEM NO. 6. 

DON ASHTON: THIS IS A HEARING ON REVISIONS TO THE DEPARTMENT OF ANIMAL CARE AND CONTROL FEE SCHEDULE, REFLECTING REVISED FEES FOR SERVICES PROVIDED TO THE PUBLIC THERE IS NO DEPARTMENT STATEMENT. NO CORRESPONDENCE WAS RECEIVED, AND THERE ARE NO SPEAKERS. 

SUP. MOLINA: ALL RIGHT. ON THAT ITEM. MOVED BY SUPERVISOR YAROSLAVSKY. SECONDED BY SUPERVISOR RIDLEY-THOMAS. IF THERE'S NO OBJECTION, SO ORDERED ON THAT ITEM. ITEM NO. 7. 

DON ASHTON: THIS IS A HEARING ON ESTABLISHMENT AND INCREASE IN PARKING RATES AT COUNTY PARKING FACILITIES LOCATED IN THE LOS ANGELES CIVIC CENTER. THERE IS NO DEPARTMENTAL STATEMENT. NO WRITTEN CORRESPONDENCE WAS RECEIVED. AND THERE IS ONE SPEAKER. 

SUP. MOLINA: ALL RIGHT. MR. SACHS? ITEM NO. 7. 

ARNOLD SACHS: THANK YOU AGAIN. ITEM NO. 7, VERY QUICKLY. WOULD THIS COUNTY AT ALL AT ANY OPPORTUNITY LOOK TO SELL THESE PARKING FACILITIES AND THE RIGHTS TO THE PARKING FACILITIES AS WAS DONE IN CHICAGO? AND MIGHT EVEN BE CONSIDERED BY THE CITY OF L.A. FOR AN UPFRONT PAYMENT? JUST A CURIOUS QUESTION REGARDING THE PARKING FACILITIES. THANK YOU. 

SUP. MOLINA: THANK YOU, MR. SACHS. ON THAT ITEM, MOVED BY SUPERVISOR RIDLEY-THOMAS, SECONDED BY SUPERVISOR YAROSLAVSKY. ITEM NO. 10, I'M SORRY. 

DON ASHTON: THIS IS A HEARING ON APPROVAL TO ENTER INTO A TEN YEAR LICENSE AGREEMENT WITH OMNI POINT COMMUNICATIONS INC. FOR USE OF A 630 SQUARE FOOT PORTION OF THE ALTADENA GOLF COURSE. THERE IS NO DEPARTMENTAL STATEMENT. NO WRITTEN CORRESPONDENCE WAS RECEIVED AND THERE ARE NO SPEAKERS. 

SUP. MOLINA: ALL RIGHT. ON THAT ITEM, MOVED BY SUPERVISOR YAROSLAVSKY, SECONDED BY SUPERVISOR RIDLEY-THOMAS, IF THERE IS NO OBJECTION, SO ORDERED. ITEM 11. 

DON ASHTON: THIS HEARING ON AMENDMENTS TO THE COUNTY CODE, TITLE 22, PLANNING AND ZONING, RELATING TO THE TOPANGA CANYON AND SANTA MONICA MOUNTAINS NORTH AREA COMMUNITY STANDARDS DISTRICTS. THERE IS A DEPARTMENTAL STATEMENT. NO CORRESPONDENCE WAS RECEIVED AND THERE ARE NO SPEAKERS. 

SUP. MOLINA: ON THAT ITEM, MOVED BY SUPERVISOR YAROSLAVSKY. 

DON ASHTON: I'M SORRY, MADAME CHAIR. THERE IS A DEPARTMENT STATEMENT. 

SUP. MOLINA: OH, THERE IS? I APOLOGIZE. 

GINA NATOLI: THANK YOU, MADAME CHAIR. 

SUP. MOLINA: THANK YOU. PLEASE PROCEED. 

GINA NATOLI: MADAME CHAIR, SUPERVISORS, GOOD MORNING. I'M GINA NATOLI, WITH THE DEPARTMENT OF REGIONAL PLANNING. IN MAY 2008, YOUR BOARD INSTRUCTED THE DIRECTOR OF REGIONAL PLANNING TO PREPARE AN ORDINANCE AUTHORIZING THE USE OF THE DIRECTOR'S REVIEW PROCEDURE TO CONSIDER YARD MODIFICATION REQUESTS WITHIN THE TOPANGA COMMUNITY OF THE SANTA MONICA MOUNTAINS AND TO RETAIN THE PROVISION THAT GROWTH STRUCTURAL AREA IS NOT SUBJECT TO MODIFICATION. IN THE ANTIQUATED AREAS OF THE TOPANGA COMMUNITY, THE VARIANCE PROCEDURE MUST BE UTILIZED TO CONSIDER REQUESTS FOR YARD MODIFICATIONS. HOWEVER IT WAS FELT THAT THE VARIANCE REQUIREMENT PLACES AN UNDUE BURDEN ON PROPERTY OWNERS, AS MOST UNINCORPORATED AREAS, INCLUDING THOSE AREAS OF THE TOPANGA COMMUNITY, OUTSIDE THE ANTIQUATED SUBDIVISIONS ALLOW CONSIDERATION OF YARD MODIFICATIONS THROUGH THE DIRECTOR'S REVIEW. THE PROPOSED AMENDMENTS PROVIDE A LESS BURDENSOME PROCEDURE FOR SPECIFIC YARD MODIFICATIONS. BY ALLOWING THE USE OF THE DIRECTOR'S REVIEW FOR APPROVING YARD MODIFICATIONS REQUESTED FOR FENCES, WALLS AND LANDSCAPING IN THE TOPANGA CANYON C.S.D. AND THE TOPANGA AREA OF THE SANTA MONICA MOUNTAINS NORTH AREA C.S.D., THESE AMENDMENTS ADDRESS YOUR BOARD'S CONCERNS AND PROMOTE SAFETY AND VISUAL RESOURCE PROTECTION IN THE TOPANGA COMMUNITY. TO ENSURE SAFETY AND VISUAL RESOURCE PROTECTION AS WELL AS DESIGN COMPATIBILITY WITH THE SURROUNDING ENVIRONMENT, THE AMENDMENTS ALSO PROPOSE DEVELOPMENT STANDARDS TO REGULATE FENCE, WALL AND LANDSCAPING HEIGHT, MATERIALS AND TRANSPARENCY. STAFF WILL CLARIFY IN THE ORDINANCE THAT LANDSCAPING PLANTED MORE THAN 10 FEET FROM THE HIGHWAY LINE IS NOT SUBJECT TO THESE AMENDMENTS. ALL NEW AND REPLACEMENT FENCES, WALLS AND LANDSCAPING IN REQUIRED YARDS THROUGHOUT THE TOPANGA COMMUNITY WILL BE SUBJECT TO THE NEW DEVELOPMENT STANDARDS. IN COMPLIANCE WITH C.E.Q.A. GUIDELINES AND THE ENVIRONMENTAL DOCUMENT REPORTING PROCEDURES AND GUIDELINES OF THE COUNTY OF LOS ANGELES, STAFF PREPARED AN INITIAL STUDY FOR THE PROPOSED AMENDMENTS. THE INITIAL STUDY SHOWED NO SUBSTANTIAL EVIDENCE THAT THE PROPOSED AMENDMENTS WILL HAVE A SIGNIFICANT EFFECT ON THE ENVIRONMENT AND THEREFORE STAFF HAS PREPARED A NEGATIVE DECLARATION FOR THIS PROJECT WHICH IS BEFORE YOU FOR CONSIDERATION. MADAME CHAIR, SUPERVISORS, THANK YOU FOR YOUR ATTENTION. THIS CONCLUDES MY PRESENTATION. 

SUP. MOLINA: OKAY. ANYONE ELSE? 

SUP. YAROSLAVSKY: YEAH, MADAME CHAIR, IS THERE ANYBODY ELSE UP THERE? 

SUP. MOLINA: SUPERVISOR YAROSLAVSKY? 

SUP. YAROSLAVSKY: ANYBODY ELSE WANT TO BE HEARD? 

SUP. MOLINA: I GUESS NOT. 

SUP. YAROSLAVSKY: I WOULD JUST BRIEFLY SAY. I APPRECIATE THE WORK THAT THE PLANNING DEPARTMENT HAS DONE ON THIS. THIS IS ATTEMPTING TO RESOLVE WHAT HAS BEEN A HARDSHIP FOR MANY PEOPLE THERE WITHOUT REALLY UNDERMINING THE ORIGINAL INTENT OF THE PROTECTIVE ORDINANCES THAT WE'VE HAD. AND I THINK YOU'VE DONE A GOOD JOB OF PROVIDING A SOLOMON-LIKE SOLUTION AND I WOULD MOVE APPROVAL. 

LARRY HAFETZ, COUNSEL: SUPERVISOR, JUST ONE CLARIFICATION. IN THE MOTION, WE WOULD ADOPT THE NEGATIVE DECLARATION, AS WELL. 

SUP. YAROSLAVSKY: WELL SOLOMON WOULD HAVE DECLARED THE NEGATIVE DECLARATION. THAT WAS IMPLIED IN MY MOTION. BUT I WILL SECOND THE LAWYER AND SAY MOVE THE APPROVAL OF THE NEGATIVE DECLARATION AND YOUR SOLOMON-LIKE PROPOSAL. THANK YOU. GLORIA, I MOVED IT. 

SUP. MOLINA: ALL RIGHT, I'M SORRY. 

SUP. YAROSLAVSKY: I MOVED IT. 

SUP. MOLINA: ALL RIGHT. IT HAS BEEN MOVED BY SUPERVISOR YAROSLAVSKY. SECONDED BY SUPERVISOR RIDLEY-THOMAS. IF THERE IS NO OBJECTION, SO ORDERED ON THAT ITEM. THANK YOU SO MUCH FOR YOUR HELP ON THAT. 

GINA NATOLI: THANK YOU. 

SUP. MOLINA: ALL RIGHT. I THINK THAT CONCLUDES ALL OF OUR HEARINGS. 

DON ASHTON: MADAME CHAIR, IF WE COULD GO BACK TO ITEMS NO. 1 AND 2, WE HAVE TABULATED THE BALLOT. 

SUP. MOLINA: ALL RIGHT. 

DON ASHTON: ON ITEM NO. 1, THERE IS NO MAJORITY-- MADAME CHAIR PRO TEM AND MEMBERS OF THE BOARD, AFTER TABULATING THE BALLOTS, A DETERMINATION HAS BEEN MADE THAT NO MAJORITY PROTEST EXISTS. AS A RESULT, IT WOULD BE APPROPRIATE FOR THE BOARD TO ADOPT THE RESOLUTION ORDERING THE PROPOSED FORMATION OF IMPROVEMENT ZONE 539, AND LEVYING OF ASSESSMENTS FOR PETITION NO. 91-805 EDDERTON AVENUE WITHIN COUNTY LIGHTING MAINTENANCE DISTRICT 1687 AND COUNTY LIGHTING DISTRICTS L.L.A.-1, UNINCORPORATED ZONE, LA MIRADA AREA. 

SUP. MOLINA: ALL RIGHT. I SO MOVE. AND A SECOND BY SUPERVISOR YAROSLAVSKY. IF THERE'S NO OBJECTION, SO ORDERED ON THAT ITEM. 

DON ASHTON: AND THEN ITEM NO. 2, AFTER TABULATING THE BALLOTS, A A DETERMINATION HAS BEEN MADE THAT NO MAJORITY PROTEST EXISTS. AS A RESULT, IT WOULD BE APPROPRIATE FOR THE BOARD TO ADOPT THE RESOLUTION ORDERING ANNEXATION AND LEVYING OF ASSESSMENTS WITHIN THE ANNEXED TERRITORY PETITION NO. 21-207 FAIRGREEN AVENUE ET AL WITHIN COUNTY LIGHTING MAINTENANCE DISTRICT 1687 AND COUNTY LIGHTING DISTRICT L.L.A.-1, UNINCORPORATED ZONE, EAST ARCADIA AREA. 

SUP. MOLINA: SO MOVED. SECONDED BY SUPERVISOR RIDLEY-THOMAS. THERE IS NO OBJECTION, SO ORDERED ON THAT ITEM. SO DOES THAT CONCLUDE ALL OF OUR HEARINGS? 

DON ASHTON: YES, IT DOES, MADAME CHAIR. 

SUP. MOLINA: ARE WE READY FOR ITEM NO. 19? A REPORT ON THE STATE BUDGET SITUATION? MR. FUJIOKA? DO YOU WANT TO DO THAT NOW OR SHOULD WE DO ADJOURNMENTS? 

C.E.O. FUJIOKA: YOUR CHOICE. THIS MORNING WE SENT UP AN UPDATE RELATED TO THE STATE BUDGET. AS YOU KNOW, THAT THE GOVERNOR IS POISED TO SIGN THE BUDGET TODAY; BUT WHAT WE DON'T KNOW IS TO WHAT EXTENT HE'LL EXERCISE HIS LINE ITEM VETO AUTHORITY TO ADDRESS WHAT IS STILL A DEFICIT IN THE STATE BUDGET. THE STATE TOOK A NUMBER OF ACTIONS-- THE STATE LEGISLATURE TOOK A NUMBER OF ACTIONS TO CLOSE 22.4 BILLION IN THE STATE'S BUDGET, BUT IT STILL LEAVES ABOUT 1.1 BILLION OUTSTANDING. LIKE I SAID, WE SENT AN UPDATE TODAY. I DON'T WANT TO GO OVER ALL OF IT, BUT I DO WANT TO HIGHLIGHT A FEW ITEMS. RIGHT NOW, AND I WANT TO EMPHASIZE AT THIS TIME WE ESTIMATE THE LOSS TO THE COUNTY WOULD BE ABOUT $190 MILLION. IT'S 189.8. BUT I QUALIFY THAT BY SAYING AT THIS TIME BECAUSE THERE'S STILL SOME QUESTIONS OUTSTANDING RELATED TO A NUMBER OF CRITICAL PROGRAMS SUCH AS THE SINGLE ALLOCATION, IN HOME SUPPORT SERVICES, AND SOME OF THE MEDI-CAL CUTS. IN ADDITION, THERE'S A PROPOSAL WHICH WILL ALLOW THE STATE TO BORROW OR SUSPEND THROUGH A SUSPENSION OF PROP 1-A, $361 MILLION IN PROPERTY TAXES OVER A THREE-YEAR PERIOD. THERE IS ALSO LANGUAGE IN THE BUDGET THAT WILL ALLOW US TO SECURITIZE THE FUNDS. HOWEVER, THE CURRENT LANGUAGE HAS A TIMING MECHANISM THAT WOULD CREATE SOME SIGNIFICANT TAX FLOW PROBLEMS FOR US. OUR STAFF, LOCALLY AND IN SACRAMENTO, ARE WORKING WITH A NUMBER OF AGENCIES AND OTHER COUNTIES TO ADDRESS THIS ISSUE. BECAUSE IT APPEARS AT THE EARLIEST WE COULDN'T SECURITIZE THE FUNDS UNTIL SOME TIME AFTER FEBRUARY, OR SOMETIMES DURING MARCH, WHICH WOULD PRESENT SOME PROBLEMS TO US. TO HIGHLIGHT JUST A FEW ISSUES, WITH THE IN HOME SUPPORT SERVICES I MENTIONED AN IMPACT THERE, THE IMPACT IS WHEN IT COMES TO THE FRAUD INVESTIGATION ACTIVITIES. THERE IS A NEW REQUIREMENT FOR IN HOME EVALUATIONS OR VISITS BY STAFF AND ALSO A FINGERPRINTING AND OTHER FRAUD ACTIVITIES. IT APPEARS THAT THE ONUS OR THE RESPONSIBILITY FOR THOSE ACTIVITIES HAVE BEEN SHIFTED TO LOCAL COUNTIES. AND FROM WHAT WE CAN TELL, IT DOESN'T IDENTIFY-- THE LEGISLATION DOESN'T IDENTIFY HOW THAT MANDATE WILL BE FUNDED. THE MEDI-CAL REDUCTION, THE STATE IS ACCESSING MONEY THAT IS CURRENTLY IN THE WAIVER THAT HASN'T BEEN ALLOCATED. THERE IS ALSO SOME IMPACT RELATED TO THE F.M.A.P. FUNDING THAT WE PREVIOUSLY DESCRIBED. BUT TO THE EXTENT THAT THE STATE WILL EXERCISE THEIR AUTHORITY TO MAXIMIZE ONLY THEIR REIMBURSEMENT FOR F.M.A.P. I MENTION THAT BECAUSE AS PART OF OUR DEPARTMENT OF HEALTH SERVICES' PLAN TO REDUCE THEIR DEFICIT, WE HAD HOPED TO ACCESS UP TO $167 MILLION IN BOTH THE WAIVER AND F.M.A.P. THE F.M.A.P. MONEY WAS FOR MEDI-CAL SERVICES THAT WERE PROVIDED. AND WE FELT THAT THERE WAS A POTENTIAL FOR SOME RETROACTIVITY THERE. ON THE HEALTHY FAMILIES PROGRAM, THE PROGRAM ELIGIBILITY REQUIREMENTS HAS BEEN REDUCED FROM 250 TO 200 PERCENT OF THE PROPERTY LEVEL. THAT COULD, OUR PRELIMINARY ESTIMATE, IDENTIFIES THE POTENTIAL IMPACT TO CLOSE TO 200,000 CHILDREN. THERE'S ABOUT 84,000 THAT WILL-- CHILDREN WHO WILL LOSE HEALTHCARE COVERAGE THROUGH THE HEALTHY FAMILIES PROGRAM. AND THERE'S ANOTHER ABOUT 113,000 WHO CAN ALSO LOSE COVERAGE THROUGH 2009 AND 2010. IT'S LIKELY THAT THOSE INDIVIDUALS WILL BECOME ELIGIBLE FOR CALIFORNIA CHILDREN SERVICES HEALTHCARE BENEFITS, WHICH HAS A 50 PERCENT COST SHARE TO THE COUNTY OF LOS ANGELES. SO WE'RE WATCHING THAT VERY CLOSELY. PROPOSITION 36 IN THE OFFENDER TREATMENT PROGRAM IS GOING TO SUSTAIN ABOUT A $22 MILLION IMPACT. THAT'S A VERY, VERY IMPORTANT PROGRAM IN OUR DEPARTMENT OF PUBLIC HEALTH, BUT ALSO IN OUR COURTS. THE CALWORKS SINGLE ALLOCATION REDUCTION IS RIGHT NOW ABOUT $114 MILLION, BUT THAT WILL CHANGE BECAUSE SOME OF THAT REFLECTS A FUNDING LEVEL THAT WAS IN THE PROPOSED MAY REVISION THAT WASN'T IDENTIFIED IN THE COUNTY BUDGET. WE'RE LOOKING AT THAT CLOSELY. THE GOOD NEWS IS THAT THE ACCESS TO THE T.A.N.F., EMERGENCY CONTINGENCY FUNDS, HAS BEEN APPROVED, WHICH WILL HELP US WITH OUR JOB PROGRAM. THAT'S ESSENTIALLY THE HIGHLIGHTS RIGHT NOW. OH, THE LAST THING I WANTED TO MENTION IS WHAT'S HAPPENING ON THE JUDICIAL SIDE. AS YOU KNOW, THE COURTS HAVE DECIDED TO EXERCISE ONE FURLOUGH DAY A MONTH, WHICH IT APPEARS AT THIS JUNCTURE COULD RESULT IN A LOSS OF $8 MILLION FOR THE SHERIFF'S DEPARTMENT DUE TO THE REDUCTION OF COURTROOM SECURITY SERVICES AND ANOTHER LOSS OF 4.6 MILLION DUE TO ELIMINATION OF THE REIMBURSEMENT OF RETIREE HEALTHCARE COSTS FOR COURT SECURITY PERSONNEL. WE STILL NEED CLARIFICATION ON THESE TWO ISSUES, AND WE'RE WORKING WITH THE SHERIFF'S DEPARTMENT. AND WE ALSO INTEND TO SIT DOWN WITH OUR FRIENDS ACROSS THE MALL AT SUPERIOR COURT. THAT'S IT AT THIS TIME. THE GOVERNOR WILL HAVE A PRESS CONFERENCE LATER TODAY. WE'RE GOING TO PARTICIPATE IN THE CONFERENCE CALL AT 3:00. WE SHOULD HAVE MORE INFORMATION TO REPORT OUT AT THE END OF TODAY. 

SUP. MOLINA: ALL RIGHT. ANY QUESTION OR COMMENTS ON THIS ITEM? IF NOT, ALL RIGHT. THAT'S A REPORT. ITEM NO. 1-D WAS HELD FOR A MEMBER OF THE PUBLIC. COULD I HAVE THAT? OH, MR. SACHS? 

ARNOLD SACHS:THANK YOU, GOOD MORNING AGAIN. I'D HOPED TO MAKE A COMMENT, PUBLIC COMMENT ABOUT THE HOUSING DEPARTMENT MEETING. LAST WEEK, I BELIEVE, I HAD MENTIONED, OR MAYBE IT WAS TWO WEEKS AGO, THAT THERE WAS A PROGRAM IN VENICE. CONGRATULATIONS, SUPERVISOR YAROSLAVSKY. AND I WAS WRONG, BECAUSE I MENTIONED THAT IT WAS $800,000 FOR A HOMELESS PROJECT. IT'S ACTUALLY $724,000 FOR A PROJECT 40 TO INITIATE A SIMILAR PROGRAM WITH THE PROJECT 50 AT SKID ROW. THE ST. JOSEPH'S CENTER HAS MODELED THE EFFORT AFTER A PROGRAM BY COMMON GROUND NEW YORK WHICH HAS HELPED CONDUCT VULNERABILITY SURVEYS OF THE HOMELESS IN 14 AREAS ACROSS THE U.S. INCLUDING SANTA MONICA, LOS ANGELES SKID ROW, NEW YORK CITY AND WEST HOLLYWOOD. $724,000. MY QUESTION WAS: HOW CAN YOU DO A PROJECT 40 FOR $724,000 AND A PROJECT 50 FOR $5.6 MILLION? THAT COMES TO PROJECT 50 COMES TO OVER $100,000 PER PERSON. THE PROJECT 40 COMES TO LESS THAN $20,000 PER PERSON. IT JUST DOESN'T SEEM TO MAKE SENSE WHEN YOU LOOK AT THOSE KIND OF NUMBERS. AND THEN WHEN YOU LOOK AT THE KIND OF NUMBERS THAT YOU USE WHEN YOU DO THE TRASH AT SUNSHINE CANYON LANDFILL, THEN IT MAKES PLENTY OF SENSE. THANK YOU. 

SUP. MOLINA: THANK YOU, MR. SACHS. ALL RIGHT. ON THAT ITEM, IT'S MOVED BY SUPERVISOR YAROSLAVSKY. SECONDED BY SUPERVISOR RIDLEY-THOMAS. IF THERE'S NO OBJECTIONS, SO ORDERED ON THAT ITEM. ALL RIGHT. WHAT IS THIS? ALL RIGHT. BEFORE WE DO S-1, LET ME DO SOME OF MY ADJOURNMENTS HERE. I HAVE AN ADJOURNMENT THAT WE ADJOURN IN THE MEMORY OF L. WILLIAM LAMPKIN, SR. HE IS THE BELOVED FATHER OF OUR GRAND AVENUE MANAGING DIRECTOR, MARTHA WELBORNE. WE WANT TO EXTEND OUR DEEPEST CONDOLENCES TO MARTHA AND HER ENTIRE FAMILY. HAVE ALL MEMBERS JOIN ON THAT? I'VE ALSO BEEN ASKED BY SUPERVISOR ANTONOVICH TO DO HIS ADJOURNMENTS. FIRST OF ALL, MARYELLEN FISHER BRENNER PASSED AWAY AT THE AGE OF 53 AFTER A VALIANT BATTLE WITH A BRAIN TUMOR. GROWING UP IN THOUSAND OAKS, MARYELLEN WENT TO ATTAIN A B.A. IN MUSIC FROM PACIFIC LUTHERAN UNIVERSITY, HER TEACHING CREDENTIALS FROM U.S. [U.C.] SANTA BARBARA, AND AN M.A. FOR EDUCATION FROM SAN DIEGO STATE UNIVERSITY. SHE LATER JOINED THE PEACE CORPS AND TAUGHT MUSIC IN KENYA WHERE SHE MET HER HUSBAND, MARTY IN 1983, SHE WAS MARRIED AND SETTLED DOWN IN LANCASTER. SHE WILL BE DEARLY MISSED BY HER HUSBAND, DAUGHTER ADRIENNE, SON ROSS, AND PARENTS ROBERT AND MARGIE. I'D LIKE TO ASK ON BEHALF OF SUPERVISOR ANTONOVICH THAT WE ALSO ADJOURN IN THE NAME OF RICHARD I. HUMPHREYS. HE PASSED AWAY AT THE AGE OF 82. HE IS A RETIRED INSPECTOR FOR THE LOS ANGELES COUNTY SHERIFF'S DEPARTMENT. HAVING DEDICATED NEARLY 30 YEARS TO PROTECTING AND SERVING THE RESIDENTS OF L.A. COUNTY, HIS LAST ASSIGNMENT WAS WITH THE ADMINISTRATIVE DIVISION. HE IS GOING TO BE GREATLY MISSED. ALSO THAT WE ADJOURN IN THE MEMORY OF DENNIS D. KEE. MR. KEE PASSED AWAY AT THE AGE OF 71. HE ALSO WAS A RETIRED SERGEANT FOR THE LOS ANGELES COUNTY SHERIFF'S DEPARTMENT WHO DEDICATED NEARLY 25 YEARS TO SERVING AND PROTECTING THE RESIDENTS OF LOS ANGELES COUNTY. HIS LAST ASSIGNMENT WAS IN THE TRANSPORTATION BUREAU AND HE, TOO, WILL BE DEARLY MISSED. I'D ASK ON BEHALF OF SUPERVISOR ANTONOVICH THAT WE ADJOURN IN THE MEMORY OF BOK PON, A CHINESE AMERICAN SOLDIER IN THE UNITED STATES ARMED FORCES DURING WORLD WAR II. PON WAS COMMANDER OF THE AMERICAN LEGION CATHAY POST 384 IN SAN FRANCISCO. A MEMORIAL WAS CONSTRUCTED BY THE CATHAY POST IN SAN FRANCISCO TO HONOR THE WORLD WAR II CHINESE AMERICAN VETERANS. ALONG WITH BEING AN OUTSTANDING ADVOCATE FOR CHINESE AMERICAN VETERANS, PON ALSO SERVED IN THE ASIAN AMERICAN COMMUNITY BY WORKING ON ISSUES OF AFFORDABLE HOUSING AND YOUTH EDUCATION. PON WAS A VICE CHAIRMAN OF THE CALIFORNIA REPUBLICAN PARTY. ALSO ON BEHALF OF SUPERVISOR MIKE ANTONOVICH AND I GUESS ALL OF US AS MEMBERS, AS WELL, THAT WE ADJOURN IN THE NAME OF ALEXANDER H. POPE. ALEXANDER H. POPE SERVED AS A LOS ANGELES COUNTY ASSESSOR FROM 1978 TO 1986. HE WAS APPOINTED BY THE BOARD OF SUPERVISORS TO FILL THE UNEXPIRED TERM OF ASSESSOR PHIL WATSON IN 1977. POPE WON THE 1978 ELECTION FOR ASSESSOR AND WAS REELECTED IN 1982. ALEXANDER POPE FACED THE CHALLENGE OF IMPLEMENTING PROPOSITION 13 PROPERTY TAX REFORMS. AS THE EXECUTIVE DIRECTOR OF THE CALIFORNIA CITIZENS BUDGET COMMISSION, HE ISSUED RECOMMENDATIONS TO REFORM THE STATE BUDGET PROCESS IN 1998, A REPORT ENTITLED A 21ST CENTURY BUDGET PROCESS FOR CALIFORNIA. OBVIOUSLY THEY DIDN'T LISTEN. HE GRADUATED FROM THE UNIVERSITY OF CHICAGO LAW SCHOOL. ALEXANDER POPE SERVED IN THE ARMY FROM 1952 TO 1954. CAN I HAVE ALL MEMBERS ON THAT ADJOURNMENT? ON BEHALF OF SUPERVISOR MIKE ANTONOVICH, THAT WE ADJOURN IN THE MEMORY OF JANE RAULSTON WHO PASSED AWAY AT THE AGE OF 88. SHE WAS A LONG TIME RESIDENT OF THE ANTELOPE VALLEY AND A MEMBER OF THE PALMDALE FIRST BAPTIST CHURCH AND LATER THE FAITH BIBLE CHURCH IN LANCASTER. SHE WORKED FOR 15 YEARS AT THE PALMDALE SCHOOL DISTRICT AND FOR 10 YEARS IN LANCASTER COMMUNITY HOSPITAL. JANE IS GOING TO BE DEEPLY MISSED BY HER CHILDREN, PAM, BETTY, DAVID AND EDWARD, AS WELL AS HER MANY GRANDCHILDREN AND GREAT GRANDCHILDREN. ALSO THAT WE ADJOURN TODAY IN THE NAME OF RAZIEL SELBREDE, WHO PASSED AWAY AT THE AGE OF 73. SHE WAS A LONG TIME RESIDENT OF GLENDALE AND IS SURVIVED BY FIVE SONS, A DAUGHTER, 10 GRANDCHILDREN AND 7 GREAT GRANDCHILDREN. SO ORDERED ON THOSE ADJOURNMENTS ADJOURNMENTS. ALL RIGHT. I KNOW IT'S NOT 11 A CLOCK, BUT ON S-1, IT'S A-- I'M SORRY? OH, ABSOLUTELY, I APOLOGIZE. 

SUP. YAROSLAVSKY: MADAME CHAIR, I'D LIKE TO ASK THAT THE BOARD ADJOURN IN THE MEMORY OF SAMUEL IRVING BELLMAN. SAMUEL BELLMAN WAS AN ACCOMPLISHED AUTHOR AND PROFESSOR WHO PASSED AWAY AT THE AGE OF 82 LAST WEEK AFTER A LONG ILLNESS. AT MR. BELLMAN'S BEDSIDE WERE HIS WIFE OF 57 YEARS, JEAN, AND SON JOEL, MY LONG TIME PRESS DEPUTY. SAM BELLMAN WAS THE FIRSTBORN SON OF LITHUANIAN IMMIGRANT PARENTS AND WAS REARED IN THE TRADITION OF REVERENCE FOR STUDY AND INTELLECTUAL PURSUIT. HE ENJOYED A LONG AND SUCCESSFUL CAREER AS A PROFESSOR OF ENGLISH IN THE CALIFORNIA STATE UNIVERSITY SYSTEM AT FRESNO, SAN LUIS OBISPO AND POMONA. HE WAS A PROLIFIC CRITIC AND ESSAYIST AND POET WHO PUBLISHED BIOGRAPHIES ON THE WRITERS MARJORIE KINNAN RAWLINGS AND CONSTANCE ROURKE. HIS WRITINGS APPEARED IN A WIDE VARIETY OF ACADEMIC JOURNALS AND UNIVERSITY PUBLICATIONS. IN ADDITION TO JEAN AND JOEL, HE IS SURVIVED BY HIS OTHER SON JONATHAN, HIS GRANDSONS, MALCOLM, CORRAN AND BENJAMIN, AND HIS SISTER, DEANNA KASTEN. I ASK THAT ALL MEMBERS JOIN IN THAT. 

SUP. MOLINA: SO ORDERED ON THOSE ITEMS. SUPERVISOR, DO YOU HAVE ANY ADJOURNMENTS? YOU DO? ALL RIGHT. 

SUP. RIDLEY-THOMAS: THANK YOU, MADAME CHAIR. PERMIT ME TO ADJOURN IN MEMORY OF FOUR PERSONS. I BEGIN WITH MARVIN [JOHN] MCMAHON, LONG TIME RESIDENT OF THE SECOND DISTRICT IN THE LIEMERT PARK COMMUNITY, A NEIGHBOR. HE SERVED IN THE CAPACITY OF THE ADMINISTRATOR AND ADMINISTRATED THE LOS ANGELES UNIFIED SCHOOL DISTRICT. SERVED IN SEVERAL LOCAL SCHOOLS. A PRODUCT OF THE ENVIRONMENT IN THE SENSE THAT HE HAS LONG-STANDING CONTRIBUTIONS AS A SPORTSMAN AS WELL AS AN EDUCATOR, COMMITTED TO CHILDREN AND AN EXTRAORDINARY WAY. DIED SUDDENLY AS A RESULT OF A HEART ATTACK THIS PAST WEEK. AND WE REMEMBER MARVIN MCMAHON WITH RESPECT AND PURPOSE. NEXT, MADAME CHAIR, MR. YAROSLAVSKY, STINSON AMEER-BROWN, JR., RESIDENT OF THE SECOND DISTRICT WHO PASSED ON JULY THE 18TH AT THE AGE OF 21. THE SON OF STINSON BROWN SR., L.A.P.D. OFFICER ASSIGNED TO THE TRAINING DIVISION. HE WAS DEVOTED AS A MEMBER OF THE CITY OF REFUGE CHURCH WHERE HIS MEMBERSHIP WAS HELD. HE WAS KNOWN BY MANY AS AN UP AND COMING ENTREPRENEUR, ALREADY DEVELOPING HIS OWN CLOTHING LINE. HE ATTENDED L.A. SOUTHWEST COLLEGE AND WAS AN AVID SPORTSMAN WITH GREAT ATHLETIC ABILITIES. HE WANTED ONE DAY TO BE A PROFESSIONAL IN THE AREA OF ATHLETICS. HE WILL BE DEEPLY MISSED BY ALL. HE LEAVES TO CHERISH HIS MEMORY HIS PARENTS, STINSON AND DENISE BROWN, HIS SISTER, VILENA BROWN, ALONG WITH A HOST OF FAMILY AND FRIENDS. JOHN H. HOLOMAN, WE'LL RECOGNIZE HIM AS ONE WHO DISTINGUISHED HIMSELF AS A BUSINESSMAN. BECAME A LICENSED REAL ESTATE BROKER WORKING IN REAL ESTATE SALES AND DEVELOPMENT AND WAS INFLUENTIAL IN THE DEVELOPMENT OF ONE OF THE AFRICAN-AMERICAN HOME DEVELOPMENTS IN THE COUNTY OF LOS ANGELES KNOWN AS CENTERVIEW IN THE CITY OF GARDENA, WHERE HE AND HIS FAMILY RESIDED FOR MANY YEARS BEFORE MOVING TO VIEW PARK, AND THEN FINALLY TO LAFAYETTE SQUARE. LATER IN HIS CAREER, HE BECAME THE FIRST AFRICAN-AMERICAN SENIOR VICE PRESIDENT OF A MAJOR BANKING INSTITUTION IN THE U.S. HE WAS AN ADVOCATE FOR EQUALITY OPPORTUNITY AND ACCESS TO MAINSTREAM FINANCIAL SERVICES FOR ALL RACES. HE ENJOYED READING BOOKS ON HISTORY AND POLITICS. HE WAS A MEMBER OF THE BOARD OF MOOREHOUSE COLLEGE, MOOREHOUSE MEDICAL SCHOOL, THE JACKIE ROBINSON FOUNDATION AND FOUNDING MEMBER OF THE CITY CLUB. HE WAS A DEVOTED FAMILY MAN AND WAS DEEPLY COMMITTED TO MENTORING AND DEVELOPING FUTURE GENERATIONS OF YOUNG PEOPLE. HE WILL BE CLEARLY BE MISSED. HE LEAVES TO CHERISH HIS MEMORY HIS WIFE, LUCILLE, AND HIS CHILDREN, STEPHANIE AND ERIC, ALONG WITH MANY WHO CONSIDERED HIM FRIENDS, CONSIDERED THEMSELVES FRIENDS AND MOST CERTAINLY THOSE WHO ARE PART OF HIS IMMEDIATE AND EXTENDED FAMILY. FINALLY MADAME CHAIR, INOLA HENRY, DEMOCRATIC NATIONAL COMMITTEE MEMBER AND LONG TIME DEMOCRATIC ACTIVIST, WHO RECENTLY PASSED. SHE WAS A LONGTIME TEACHER IN THE LOS ANGELES UNIFIED SCHOOL DISTRICT AND DEDICATED TO EDUCATION AND SOCIAL JUSTICE. SHE HELPED TO FORM THE WATTS SUMMER FESTIVAL AFTER THE 1965 UPRISING AND RIOTS. SHE HAD BEEN INVOLVED IN DEMOCRATIC POLITICS SINCE THE 1960S. SHE SERVED AS THE RESOLUTIONS COMMITTEE CHAIRWOMAN OF THE DEMOCRATIC PARTY OF CALIFORNIA FOR DECADES AND SHE LEAVES TO CHERISH HER MEMORY A HOST OF FAMILY AND FRIENDS. 

SUP. MOLINA: I'D JOIN WITH YOU ON THAT ADJOURNMENT. 

SUP. RIDLEY-THOMAS: ALL MEMBERS. THANK YOU. AND ALSO, MR. YAROSLAVSKY, PLEASE ADD HIM TO JOHN HOLOMAN, AS WELL AS MISS MOLINA. AND THAT INCLUDES MY-- 

SUP. MOLINA: SO ORDERED ON THOSE ADJOURNMENTS, THANK YOU. BEFORE I MOVE OVER TO PUBLIC COMMENT, I'D LIKE TO INTRODUCE A MOTION FOR NEXT WEEK. AND I'LL HAVE MY STAFF PASS OUT. "LOSING TO CHILDREN ABUSE AND NEGLECT IS TRAGIC. WHILE IT MAY NOT BE POSSIBLE TO PREVENT EVERY CHILD DEATH, WE MUST CONTINUE TO FIND WAYS TO STRENGTHEN POLICIES AND PROTOCOLS TO SECURE THE SAFETY OF OUR CHILDREN UNDER OUR JURISDICTION. THE DISTURBING NUMBER OF CHILD DEATHS THAT HAVE OCCURRED RECENTLY REQUIRES IMMEDIATE ACTION. THE DEPARTMENT OF CHILDREN AND FAMILY SERVICES MUST IMPLEMENT TIGHTER MANAGEMENT CONTROLS TO ENSURE THAT SOCIAL WORKERS CONDUCT THEIR DAY-TO-DAY RESPONSIBILITIES AS REQUIRED BY D.C.F.S. POLICIES AS WELL AS STATE LAWS. THIS INCLUDES MONITORING EACH AND EVERY FACE-TO-FACE CONTACT THEY MAKE AND EVERY INTERVIEW THEY CONDUCT OF A NEIGHBOR, TEACHER, RELATIVE OR FRIEND TO ASSESS THE ENTIRE HEALTH, MENTAL HEALTH AND THE WELL-BEING OF THE FAMILY UNIT. ONE OF THE ESSENTIAL FACTORS IN DETERMINING A CHILD'S SAFETY IS THE RELIANCE ON MEDICAL AND MENTAL HEALTH PROFESSIONALS. MANY TIMES, CHILDREN ARE SENT TO PRIVATE HEALTHCARE PROVIDERS WHO MAY NOT HAVE THE EXPERTISE NECESSARY IN CHILD ABUSE AND NEGLECT. WITH THE RECENT DEVELOPMENT OF OUR MEDICAL HUB SYSTEM, WE HAVE THE OPPORTUNITY TO RELY UPON OUR OWN COUNTY DEPARTMENT EXPERTS TO TRACK THE WELL-BEING OF CHILDREN THAT COME TO THE ATTENTION OF THE DEPARTMENT OF CHILDREN AND FAMILY SERVICES THROUGH THE 14,000 CALLS IN ONE MONTH TO A HOTLINE. WE MUST EXAMINE HOW STRONGER INTERNAL MANAGEMENT CONTROLS AND ACCOUNTABILITY, COUPLED WITH MULTIDEPARTMENTAL COORDINATION, THAT IS THE DEPARTMENT OF CHILDREN AND FAMILY SERVICES, THE DEPARTMENT OF MENTAL HEALTH AS WELL AS THE DEPARTMENT OF HEALTH SERVICES CAN BETTER SUPPORT AND TRACK THE SAFETY PLANS DEVELOPED BY THE CHILDREN-- FOR CHILDREN IN THIS COUNTY. I THEREFORE MOVE THE DEPARTMENT OF CHILDREN AND FAMILY SERVICES ENHANCE ITS COMPUTERIZED MANAGEMENT OVERSIGHT TO ENSURE THAT ALL VISITS ARE COMPLETED, THAT CASE NOTES ARE REFLECTED IN THE SERVICES PROVIDED, AND THAT ALL LEVELS OF MANAGEMENT, INCLUDING CHILDREN SOCIAL WORKER, SUPERVISING SOCIAL WORKER, THE ASSISTANT REGIONAL ADMINISTRATOR AND THE REGIONAL ADMINISTRATOR REVIEW REFERRALS, CONFIRM THAT VISITS HAVE BEEN COMPLETED AND REVIEW THE QUALITY OF SERVICES BEING PROVIDED TO A FAMILY. I FURTHER MOVE THAT THE DEPARTMENT OF CHILDREN AND FAMILY SERVICES ENSURE MANAGEMENT HAS REVIEWED ALL OF THE DOCUMENTS AND CASE NARRATIVES OF DOCTORS' VISITS, COLLATERAL CONTACTS, MENTAL HEALTH EVALUATIONS, ET CETERA PRIOR TO APPROVING THE DISPOSITION OF A COMPUTER RECORD. FURTHERMORE, ALL UNFOUNDED REFERRALS MUST BE REVIEWED BY THE SUPERVISING SOCIAL WORKER AND THE ASSISTANT REGIONAL ADMINISTRATOR WITH THE FINAL ACCOUNTABILITY RESTING WITH THE REGIONAL ADMINISTRATOR. ADDITIONAL TRIGGERS THAT WILL REQUIRE THE EVALUATION UNDER THE DIRECTION OF THE OFFICE OF THE DEPARTMENT OF CHILDREN AND FAMILY SERVICES' MEDICAL DIRECTOR INCLUDE ANY MEDICAL OR MENTAL HEALTH CONCERNS OF THE CHILDREN OR CAREGIVERS THAT WOULD HAVE A NEGATIVE IMPACT ON THE CHILD AND/OR WHEN A SAFETY PLAN INCLUDES ELDERLY CAREGIVERS. I FURTHER MOVE THAT THE DEPARTMENT OF CHILDREN AND FAMILY SERVICES CONSIDER A PILOT TO BE IMPLEMENTED AT THE L.A. COUNTY+U.S.C. EAST SAN GABRIEL VALLEY MEDICAL HUB WHERE FAMILIES' HEALTH AND MENTAL HEALTH CAN BE TRACKED IN A COORDINATED MANNER. SUCH COORDINATION WOULD ENABLE THE DEPARTMENT OF CHILDREN AND FAMILY SERVICES WOULD RELY ON INTERNAL TRUSTED COUNTY DEPARTMENTS THAT POSSESS THE EXTENSIVE EXPERIENCE IN CHILD ABUSE AND NEGLECT NOT ALWAYS PRESENT AMONGST PRIVATE HEALTHCARE PROVIDERS. I DIRECT THE DEPARTMENT OF CHILDREN AND FAMILY SERVICES, THE C.E.O., DEPARTMENT OF HEALTH SERVICES AND THE DEPARTMENT OF MENTAL HEALTH TO REPORT ON THE FEASIBILITY OF IMPLEMENTATION OF THESE RECOMMENDED ACTIONS AT THE AUGUST 25TH, 2009 BOARD MEETING." I'M SORRY? I AM DONE. SUPERVISOR RIDLEY-THOMAS DIDN'T UNDERSTAND THE SIGNALS THERE. 

SUP. RIDLEY-THOMAS: THANK YOU VERY MUCH, MADAME CHAIR. CONSISTENT WITH THE THEME THAT YOU JUST ESTABLISHED, LET ME PROCEED IN THE FOLLOWING MANNER. "ON THURSDAY, JULY 23RD, POLICE OFFICERS WERE CALLED TO A RESIDENT ON-- RESIDENCE ON EAST 87TH PLACE IN THE CITY OF LOS ANGELES WHERE THEY FOUND THE BODY OF A 6-YEAR-OLD DEVON BAILEY. THE AUTOPSY REPORT IS PENDING. THE DIRECTOR OF THE DEPARTMENT OF CHILDREN AND FAMILY SERVICES HAS OPENED AN INVESTIGATION AND IS REVIEWING THE CIRCUMSTANCES INVOLVING THIS CHILD'S DEATH AS WELL AS ALL PRIOR CONTACTS MADE TO D.C.F.S. REGARDING THE CHILD. THE COUNTY OF LOS ANGELES IS RESPONSIBLE FOR THE WELL-BEING AND THE SAFETY OF THE CHILDREN IN THE CARE OF D.C.F.S. AND D.C.F.S. CHILD MORTALITY REPORTS INDICATE IN THE LAST YEAR OVER A DOZEN CHILDREN DIED PURSUANT TO ALLEGATIONS OF ABUSE. IN THE SECOND SUPERVISORIAL DISTRICT, THERE HAS BEEN A DISPROPORTIONATE NUMBER OF SUCH DEATHS INVOLVING CHILDREN, ACCORDING TO D.C.F.S. THERE IS A CRITICAL AND IMMEDIATE NEED TO ADDRESS AND AMELIORATE THIS SITUATION. THE RECOMMENDED STEPS INCLUDED-- INCLUDE THE EFFORT TO, FIRST, IDENTIFY ANY BREAKDOWN OR DEFICIENCY IN EXISTING POLICIES. SECOND, REVIEW AN INVESTIGATIVE REVIEW-- REVIEW AND INVESTIGATE PROCESSES SUCH AS THE STRUCTURE DECISION MAKING TOOL USED BY SOCIAL WORKERS. THIRD, COLLECT, ANALYZE AND SHARE DATA THROUGH THE SYSTEMS IN PLACE, SUCH AS THE FAMILY AND CHILDREN INDEX. AND, FOURTH, IMPLEMENT MEASURES TO REDUCE RISK TO CHILDREN. IN RESPONSE TO A BOARD ACTION ON APRIL 28TH, THE CHIEF EXECUTIVE OFFICER ISSUED A REPORT JUST THIS PAST WEEK ABOUT THE QUALITY AND AVAILABILITY OF SERVICES FOR AT-RISK CHILDREN AND FAMILIES. THE TRAINING STANDARDS FOR CHILDREN'S SOCIAL WORKERS. SOME OF WHAT STILL REMAINS TO BE EXAMINED IS THE CASELOAD, THE RATIO AND THE ASSIGNMENT PROCESSES FOR SOCIAL WORKERS AT EACH LEVEL TO ENSURE THAT CHILDREN ARE ADEQUATELY SERVED AND THEIR CASES GIVEN THE FULL AND NECESSARY ATTENTION. IN ADDITION, THE COUNTY IS CONDUCTING A SEARCH FOR THE LEAD ATTORNEY IN THE CHILDREN'S SPECIAL INVESTIGATIONS UNIT WHO WILL BE CHARGED WITH PROVIDING THE BOARD WITH AN INDEPENDENT LEGAL REVIEW OF CHILDREN'S DEATH AND SERIOUS INCIDENTS OF CHILD ABUSE OR NEGLECT. CANDIDATES ARE CURRENTLY BEING INTERVIEWED. AND IT IS IMPERATIVE THAT WE PLACE A HIGH PRIORITY ON FILLING THIS POSITION AND MOVE FORWARD AS SOON AS HUMANLY POSSIBLE. I THEREFORE MOVE THAT THE BOARD OF SUPERVISORS DIRECT THE C.E.O. TO, FIRST, WORK WITH THE ACTING DIRECTOR OF PERSONNEL AND REPORT BACK TO THE BOARD AT ITS MEETING OF AUGUST 11TH ON THE STATUS OF HIRING THE LEAD ATTORNEY FOR THE CHILDREN'S SPECIAL INVESTIGATIVE UNIT, AND TO INCLUDE A TIMETABLE IN THE REPORT WITH AN EMPHASIS ON FILLING THIS POSITION. SECOND, WORK WITH THE BOARD, WITH THE DIRECTOR OF THE DEPARTMENT OF CHILDREN AND FAMILY SERVICES AND REPORT BACK TO THE BOARD AT ITS MEETING ON AUGUST THE 18TH OF A REVIEW OF THE EVALUATION AND EFFICACY OF THE STRUCTURE OF DECISION MAKING TOOL USED BY SOCIAL WORKERS IN PREDICTING THE LIKELIHOOD OF CHILD ABUSE AND THE EXISTING CASELOAD RATIO FOR EACH LEVEL OF CHILDREN SOCIAL WORKERS WHICH IS TO INCLUDE A COMPARISON WITH SURROUNDING COUNTIES AND BEST PRACTICES, INCLUDING RECOMMENDATIONS FOR AN OPTIMUM RATIO, STAFFING RATIO AND CASE ASSIGNMENT PROCESSES. AND, THREE, WORK WITH THE AUDITOR CONTROLLER AND THE DIRECTOR OF THE DEPARTMENT OF CHILDREN AND FAMILY SERVICES TO FIRST GATHER THE DEMOGRAPHICS OF ALL CHILDREN IN D.C.F.S. SYSTEM AND THE FATALITIES FOR THE LAST THREE YEARS AND, SECONDLY, IDENTIFY ANY UNDERLYING TRENDS OR ISSUES. AND, FINALLY, ANALYZE THOSE TRENDS AND ISSUES TO DETERMINE HOW THEY MAY CONTRIBUTE TO DEFICIENCIES IN EXISTING POLICIES AS THEY RELATE TO THE IDENTIFYING, ASSIGNING, REPORTING AND MONITORING CASES AND REPORT BACK TO THE BOARD AT ITS MEETING ON SEPTEMBER 29, 2009." I SO MOVE, MADAME CHAIR. 

SUP. MOLINA: VERY GOOD. SECONDED BY MYSELF. THIS IS A REPORT BACK, SO I THINK WE CAN MOVE THIS ONE FORWARD. THE OTHER ONE WOULD BE ON THE AGENDA FOR NEXT WEEK. ALL RIGHT. IF THERE'S NO OBJECTION, SO ORDERED ON THAT ITEM. 

SUP. RIDLEY-THOMAS: THANK YOU. I HAVE AN ADDITIONAL TO READ IN THEN IF I MAY, MADAME CHAIR. 

SUP. MOLINA: ALL RIGHT. 

SUP. RIDLEY-THOMAS: "A PROPOSAL FOR AMENDMENTS TO THE BALDWIN HILLS COMMUNITY STANDARDS DISTRICT ZONING ORDINANCE. IN OCTOBER 2008, THE COUNTY AMENDED THE ZONING CODE, APPROVING THE BALDWIN HILLS COMMUNITY STANDARDS DISTRICT TO REGULATE ALL DRILLING OPERATIONS AT THE BALDWIN HILLS OIL FIELD. OVER THE PAST TWO YEARS, NUMEROUS STAKEHOLDERS HAVE RAISED QUITE A NUMBER OF CONCERNS ABOUT THE SUFFICIENCY OF LAND USE REGULATION AND THE PROTECTION OF SAFETY AND WELFARE OF THE SURROUNDING COMMUNITIES. FOR EXAMPLE, DESPITE THE REGULATIONS IMPOSED BY THE COMMUNITY STANDARDS DISTRICT, CONCERNS REMAIN REGARDING POTENTIAL HEALTH IMPACTS, THE AESTHETICS OF THE OIL FIELD, THE NUMBER OF NEW ALLOWABLE WELLS. IN ADDITION, MANY HAVE ASSERTED THAT APPROVAL OF THE COMMUNITY STANDARDS DISTRICT WAS NOT SUFFICIENTLY VETTED WITH THE COMMUNITY, IN ADDITION TO INFORMAL COMPLAINTS, THESE CONCERNS HAVE BEEN RAISED IN FOUR PENDING LAWSUITS WHICH CHALLENGED THE APPROVAL OF THE C.S.D. AND ITS RELATED ENVIRONMENTAL IMPACT REPORT. WHILE THE ALLEGATIONS IN THE C.S.D. MAY BE A START IN DEALING WITH THE IMPACTS FROM OIL FIELD OPERATIONS, IN LIGHT OF THE CONTINUING CONCERNS RAISED BY STAKEHOLDERS IN THE COMMUNITY SURROUNDING THIS OIL FIELD, A ZONING ORDINANCE THAT REGULATES THE LONG-TERM USE OF OIL EXTRACTION ON THIS LAND SHOULD ENSURE THAT THE COUNTY PRIORITIZES PROTECTING THE HEALTH, THE SAFETY AND THE WELL-BEING OF THE COMMUNITY. I THEREFORE MOVE THAT THE ACTING DIRECTOR OF THE DEPARTMENT OF REGIONAL PLANNING INITIATE A STUDY TO CONSIDER AMENDMENTS TO THE C.S.C. ORDINANCE, WHICH INCLUDE ENHANCEMENTS OR MODIFICATIONS OF REGULATIONS FOR THE BENEFIT OF THE COMMUNITY-RELATED AESTHETICS, THE INTENSITY OF THE DRILLING AT THE SITE AND HEALTH IMPACTS THROUGH MEASURES WHICH MAY INCLUDE BUT NOT LIMITED TO THE FOLLOWING: REVISING THE NUMBER OF NEW WELLS, IMPOSING CONTROLS, CONSIDERING ESTABLISHING AN END DATE FOR DRILLING, THE POSSIBILITY OF UNDERGROUND ELECTRICAL SERVICE, THE POSSIBILITY OF UNDERGROUNDING ALL PIPING, PROVIDING FOR VISUAL SCREENING, PROVIDING FOR IMMEDIATE RESTORATION OF VEGETATION AND TOPOGRAPHY, AND, FINALLY, ENSURING THE ADEQUACY OF THE REQUIRED HEALTH STUDY. I FURTHER MOVE THAT AFTER COMPLETION OF THIS STUDY, THE ACTING DIRECTOR OF THE DEPARTMENT OF REGIONAL PLANNING PROVIDE PRELIMINARY RECOMMENDATIONS TO THE MULTIPLE AGENCY COORDINATION COMMITTEE AND COMMUNITY ADVISORY PANEL FOR REVIEW AND COMMENT. SECONDLY, CONVENE A PUBLIC HEARING BEFORE THE REGIONAL PLANNING COMMISSION TO CONSIDER POSSIBLE AMENDMENTS TO THE C.S.D., AND THAT THE PLANNING COMMISSION MAKE A RECOMMENDATION TO THIS BOARD REGARDING POSSIBLE AMENDMENTS OR MODIFICATIONS TO THE C.S.C. FOR THE BOARD'S CONSIDERATION." I SO MOVE, MADAME CHAIR. 

SUP. MOLINA: ALL RIGHT. THAT ITEM WILL BE ON FOR NEXT WEEK. ALL RIGHT. IT IS NOW 11 O'CLOCK, AND I GUESS WE CAN CALL ITEM S-1. NOW I'VE READ THE REPORT. I DON'T KNOW IF ANY BOARD MEMBER HAS ANY QUESTION OR COMMENT. I HAD SOME QUESTIONS, BUT THEY'RE GOING TO GET THEM FOR ME. SO I'M SATISFIED WE DON'T NEED AN ORAL REPORT. BUT GENEVIEVE CLAVREUL WOULD LIKE TO ADDRESS THIS ISSUE. COME UP AND JOIN US, GENEVIEVE? 

DR. GENEVIEVE CLAVREUL: GOOD MORNING, BOARD OF SUPERVISORS, DR. GENEVIEVE CLAVREUL. I AM CONCERNED THAT WE STILL HAVE A LONG WAITING TIME IN THE EMERGENCY ROOM. AND SIX MONTHS, WE HAVE THE HIGHEST NUMBER OF PATIENTS LEAVING WITHOUT SEEING, BEING TREATED. OF COURSE WHEN YOU HAVE TO WAIT 10 HOURS TO BE SEEN IN THE E.R., I'M NOT SURPRISED PEOPLE ARE LEAVING WITHOUT BEING SEEN. ALSO IT IS NEVER BREAKING DOWN ON THE PEDIATRIC SIDE. I WONDER HOW LONG PEDIATRIC PATIENTS HAVE TO WAIT. AND THAT'S NEVER IDENTIFIED. ONLY DID WITH ADULTS. I WOULD BE VERY INTERESTED TO SEE THAT BEING TAKEN CARE OF. SO THAT WILL BE A BIG IMPROVEMENT IF WE COULD LOOK AT THAT. I'M SURE YOU HAVE A QUESTION. 

SUP. MOLINA: WE HAVE SOME QUESTIONS. 

DR. GENEVIEVE CLAVREUL: MY LAST ARTICLE, MY MOST RECENT ARTICLE IS IS ON THE NURSING SHORTAGE. IT IS NOT OVER. I THINK YOU WILL APPRECIATE IT. THANK YOU. 

SUP. MOLINA: ALL RIGHT. THANK YOU. GIVE THAT TO THE OFFICER, THEY WILL PASS THEM OUT. VERY GOOD. THANK YOU. ALL RIGHT. SUPERVISOR YAROSLAVSKY, DO YOU HAVE ANY OTHER ISSUES AT ALL? SUPERVISOR RIDLEY-THOMAS, ANY OTHER ISSUES BEFORE I GO ON PUBLIC COMMENT? NO. ALL RIGHT. FOR PUBLIC COMMENT, FIRST OF ALL WE HAVE ARNOLD SACHS, JOINED BY NICHOLAS KFOURI, IF HE WOULD JOIN US. AND FOLLOWED BY DOLOREZ RAMOS, IF THEY WOULD ALL COME UP. MR. SACHS? 

ARNOLD SACHS: THANK YOU, GOOD MORNING. I'D LIKE TO TAKE THIS PUBLIC COMMENT TIME TO TALK ABOUT AN ITEM THAT APPEARED ON THE M.T.A. BOARD MEETING THAT WAS HELD LAST THURSDAY. AND THAT WAS THIS CONTRACT WITH ALDO BAREDA, REGARDING THE RAIL CARS THAT HAVE BECOME QUITE A CONTENTIOUS ITEM, SOMEWHAT. AND IT ALMOST SEEMED LIKE BECAUSE OF THE NEWS THAT WAS IN THE L.A. TIMES AND SOME OTHER PUBLICATIONS REGARDING THEIR TIES TO THE IRANIAN ELECTRICAL ENERGY PRODUCTION FOR THE NUCLEAR WEAPONS, THAT IT WOULD BE A REASON TO DROP THE CONTRACT ALTOGETHER. AND THEN THE COMEBACK WAS THAT THE COMPANY'S OFFERED A $300 MILLION SECURED BOND BASED ON THEIR PERFORMANCE. AND AFTER THE MEETING, I WAS THINKING ABOUT IT BECAUSE SOMEBODY GOT UP, I BELIEVE ONE OF THE COUNCILMEMBERS FROM ONE OF THE FOOTHILL AREA CITIES, GOT UP AND SPOKE ABOUT A PUBLIC/PRIVATE PARTNERSHIP FOR BUILDING THE FOOTHILL EXTENSION. AND I THOUGHT WELL THIS IS A PERFECT TIME TO DISCUSS THE PUBLIC/PRIVATE PARTNERSHIP. WHY NOT GET IN THE PUBLIC/PRIVATE PARTNERSHIP WITH ALDO BAREDA? THEY HAVE $300 MILLION. THEY'RE PUTTING IT OUT BASED ON, QUOTE/UNQUOTE, "THEM BEING ABLE TO MEET PERFORMANCE STANDARDS." WHICH, SO FAR THEY HAVEN'T BEEN ABLE TO MEET. THEY'VE TALKED TO THE BANKS. THEY HAVE FIVE BANKS IN LINE, OR SIX BANKS, EACH ONE IN LINE FOR $50 MILLION. WHY NOT CALL THEIR BLUFF AND ASK FOR THE $300 MILLION UP FRONT TO USE FOR RAIL CONSTRUCTION? IT'S A WIN/WIN SITUATION. YOU HAVE MONEY, THE M.T.A. HAS MONEY COMING IN FROM ITS HALF CENT SALES TAX. THEY HAVE BANKS LINED UP WITH $300 MILLION. PLUS, THEY'RE WILLING TO WAGER IT, AGAIN, ON THEIR PERFORMANCE. SO FAR, THEY HAVEN'T MADE ANY PERFORMANCE STANDARDS AT ALL. SO THE CHANCES OF THEM LOSING THIS $300 MILLION, I DON'T KNOW. IT'S A DYSFUNCTIONAL COMPANY DEALING WITH AN AGENCY THAT PUT THE DYSFUNCTION IN DYSFUNCTIONAL, THE M.T.A. A PERFECT MARRIAGE. WHAT WOULD IT TAKE TO LOOK INTO HAVING THEM PROVIDE THE FUNDING AND CONTRACTING AND THE PUBLIC BENEFITING FROM THIS $300 MILLION THAT THEY'RE SO WILLING TO OFFER? IN ADDITION TO THE PLANT THAT THEY WANT TO BUILD IN THE CITY OF L.A. BECAUSE THEY SHOULDN'T BE TIED TOGETHER. THANK YOU. SOMETHING TO CONSIDER. 

SUP. MOLINA: THANK YOU, MR. SACHS. 

NICHOLAS FFOURI: GOOD MORNING, BOARD OF SUPERVISORS. I HAVE A PROBLEM THAT I AM TRYING TO RESOLVE BUT I CANNOT GET THE ATTENTION THAT'S REQUIRED FROM THE SHERIFF'S DEPARTMENT. THE SITUATION IS IF SOMEBODY WOULD WRITE A BAD CHECK, IN MY UNDERSTANDING, IT IS CONSIDERED A CRIME. OR IF SOMEBODY STEAL SOMETHING THAT BELONGS TO ANOTHER, IT IS CONSIDERED A CRIME. MY FATHER REPORT WITH THE SHERIFF DEPARTMENT IN COMPTON, BUT THE SERGEANT THAT WAS ASSIGNED TO INVESTIGATE THE MATTER REFUSED TO TAKE A REPORT AND REFUSED TO EVEN INVESTIGATE. KNOWING THAT CAPTAIN WILLIAM RYAN IS THE ONE THAT ASKED HIM TO DO THE REPORT AND TO INVESTIGATE. SO I HAVE A DILEMMA AND I DO NOT UNDERSTAND WHY I AM BEING TREATED AS A SECOND-CLASS CITIZEN. I HAVE A COPY OF THE REPORT HERE. BUT NOTHING WAS DONE ON IT. SO I DON'T KNOW WHERE TO GO FROM HERE. AND I WOULD REALLY APPRECIATE ANY ASSISTANCE THAT YOU CAN PROVIDE IN THIS MATTER. THANK YOU VERY MUCH FOR YOUR TIME. 

SUP. MOLINA: THANK YOU. SIR, I THINK THEY HAVE, I THINK SOMEBODY FROM SUPERVISOR RIDLEY-THOMAS'S OFFICE. 

SUP. RIDLEY-THOMAS: MY CHIEF OF STAFF. 

NICHOLAS KFOURI: THANK YOU AGAIN. 

SUP. MOLINA: [INAUDIBLE.] 

SUP. RIDLEY-THOMAS: THE GENTLEMAN RIGHT HERE. 

SUP. MOLINA: (OFF MIC.) 

DELOREZ RAMOS: ALL RIGHT. GOOD MORNING, BOARD MEMBERS. I WANT TO START OFF BY THANKING SUPERVISOR YAROSLAVSKY AND HIS STAFF, WHO TRULY SERVE THEIR CONSTITUENTS. WITHOUT THIS FORUM, D.C.F.S. WOULD HAVE CONTINUED TO ABUSE THEIR AUTHORITY WITH EVERYTHING FROM TRYING TO BRING ME UP ON THINGS HAVING TO DO WITH MENTAL STABILITY, JAIL AND EVEN AT ONE POINT JOCELYN PALIN SAID USUALLY WHEN KIDS ARE TAKEN AWAY IT'S BECAUSE OF DRUGS. WELL, AGAIN, PROUD TO SAY I'VE NEVER USED DRUGS OR ALCOHOL, BUT THAT DIDN'T STOP D.C.F.S. THEY'VE DONE-- THEY GRABBED AT STRAWS FOR 17 MONTHS NOW. NOW TO KEEP MY CHILDREN FROM ME, THEY'RE SAYING THAT MY YOUNGEST HAS MILD MENTAL RETARDATION. AN ASSESSMENT WAS SUPPOSEDLY DONE, WHICH NOBODY BOTHERED TO TELL ME. I HAD NO INPUT, ANY KNOWLEDGE OF IT, JUST LIKE I HAVE NO-- I'VE BEEN PROHIBITED, IF YOU WILL, FROM HER EDUCATION. AND I HAVE TO SAY THAT THE BOARD CANNOT-- I JUST HEARD WHAT SUPERVISOR RIDLEY-THOMAS SAID, BUT THE BOARD CAN'T FORCE SOMEONE WHO'S PREJUDICED TO NOT ABUSE THEIR AUTHORITY. IF A SOCIAL WORKER DOESN'T LIKE YOU, THEY DON'T LIKE YOU. IT SADDENS ME, AND I HAVE TO MENTION, TOO, THE SIX-YEAR-OLD CHILD THAT DIED AS A RESULT OF ABUSE. WHEN I REPORTED MY YOUNGEST CHILD BEING ABUSED, SHE WAS IGNORED BY JOCELYN PALIN. SHE WAS FOREVER BEATEN UP BY BULLIES TO THE POINT THAT I HAD TO GO AND FILE POLICE REPORTS. JOCELYN'S EXCUSE, "WELL IT'S JUST CHILD'S PLAY?" WELL WHY IS MY CHILD THE ONLY ONE BEING HURT? SHE WAS ALSO HURT BY A RELATIVE. NO, I DON'T CARE. YOU HURT MY CHILD, I'M GOING TO REPORT YOU. AGAIN, IGNORED. AND THEN I WENT ON THE INTERNET AND I SAW WHERE IT SAYS FOSTER CARE FUND WAIVER TO EXPEND D.C.F.S. SERVICES BUDGET TO ALLOCATE TO HELP KEEP FAMILIES TOGETHER. AND WHY I DON'T KNOW THE WEST L.A. D.C.F.S. OFFICE IS DOING EVERYTHING TO KEEP US APART. SUPERVISOR ANTONOVICH IS QUOTED AS SAYING "THIS IS GOING TO SUPPORT THOSE ABUSED AND NEGLECTED CHILDREN IN FINDING STABLE HOMES WHICH THEY NEED TO GROW UP IN A HEALTHY ENVIRONMENT. CHILDREN ARE A GIFT OF GOD. BUT ASSISTANCE IS REQUIRED. IT MEANS HAVING HEALTHY FAMILIES AND GOOD COMMUNITIES FOR SUPPORT." WELL EVERY CHILD IS NOT ABUSED OR NEGLECTED. SOME ARE JUST HOMELESS AND ALL THEY NEED IS A STABLE HOME IN ORDER TO SURVIVE. BUT EVERYBODY IS JUST LINKED TOGETHER AS ABUSED. AND THE CHILDREN WHO TRULY ARE ABUSED, THOSE ARE THE ONES THAT END UP DEAD. AND THE ONES THAT THE PARENTS ARE JUST DOING THE BEST THEY CAN, THOSE ARE THE ONES THAT D.C.F. SEEMS TO JUST TAKE AND MAKE A FEDERAL CASE OUT OF, LIKE THEY HAVE WITH ME. 17 MONTHS LATER THEY STILL HAVE NOTHING. I MEAN I'M STILL GETTING MONITORED VISITS. NEVER ANY-- ANYTHING IN MY PAST ABUSED ANY CHILD, ESPECIALLY NOT MY OWN. YET I'M STILL A THREAT TO MY CHILD. I'VE GONE THROUGH EVERYBODY OF ANY IMPORTANCE. STILL, SAME THING. 

CHONTEL ROLISON: HI, MRS. MOLINA. THANK YOU FOR GIVING ME THIS TIME. I SYMPATHIZE WITH HER TOTALLY. I WAS SET UP BY NOT ONLY MY BABY'S FATHER, I FOUND OUT PROOF, I HAVE IT HERE, OF THE SETUP. IT STARTED IN 2001. I HAVE THE REFERRAL DATE IN HISTORY OF IT RIGHT HERE. I WAS SET UP BY PAUL EMMANUEL HOGAN. I WAS SLEEPING NEXT TO THE ENEMY FOR 5-1/2 YEARS. FAMILY, THEY KNEW OF IT AND NO ONE CAME TO MY RESCUE TO TELL ME. REGARDLESS OF WHATEVER WAS SAID ABOUT FAMILY MEMBERS, I'VE NEVER TURNED MY BACK ON FAMILY. TO THIS DAY, IT'S BEEN 10 YEARS I HAVE NOT SPOKEN TO THEM, I HAVE NOT SEEN THEM FOR HOLIDAYS. THEY'VE NEVER BEEN NORMAL. THEY'RE STILL TREATING ME LIKE A CRIMINAL. AS FAR AS MY KIDS, I DON'T KNOW WHERE THEY LIVE, I DON'T KNOW WHAT SCHOOLS THEY ATTEND. I DON'T KNOW ANYTHING ABOUT THEIR HEALTH RECORDS, THEIR EDUCATIONAL LEVELS, THEIR DENTIST, WHEN THEY GO TO THE DENTIST, THEIR PHYSICAL HEALTH. I HAVE NO IDEA. THEY'RE TREATING ME LIKE A TOTAL CRIMINAL WHEN I'M NOT. I'VE BEEN DEHUMANIZED. MY CIVIL RIGHTS HAVE BEEN VIOLATED IN EVERY, EVERY CIRCUMSTANCE IN THIS CASE. THE TRIALS HAVE NOT EVER, THE PILLS HAVE NOT EVER BEEN FAIR, I HAVE NOT BEEN GIVEN A FAIR TRIAL. I HAVE LETTERS SUGGESTING TO YOU GUYS HOW A GOOD PARENT-- HOW I'M A GOOD PARENT. AND THE WAY HE SET ME UP WAS USING THE DRUGS. HE BOUGHT THE DRUGS IN THE HOME. HE BOUGHT THE ALCOHOL IN THE HOME. THEY WERE SETTING ME UP FOR DOWNFALL, BASICALLY. NO ONE EVER WANTED TO SEE ME SUCCESSFUL AND HAPPY. FOR SOME REASON CERTAIN FAMILY MEMBERS SEGREGATED ME BECAUSE I TOLD THE TRUTH AGAIN ABOUT BEING MOLESTED. BECAUSE OF THIS, MY LIFE WAS DESTROYED FOR OVER A DECADE. AND I REFUSED TO LET THESE PEOPLE, JUST BECAUSE OF THE WAY I LOOK ON MY OUTER, JUDGE MY INNER. I'M A GOOD MOTHER. I'VE NEVER NEGLECTED MY KIDS, EVER. AND I WANT YOU GUYS TO KNOW THAT I AM FILING CHARGES BECAUSE I'M ENTITLED TO FILING THESE CIVIL CHARGES AGAINST D.P.S.S. FOR HAVING GOING ALONG WITH THE SETUP. THEY DID NOT RIGHTFULLY TREAT MY KIDS FAIR. THEY DID NOT LISTEN TO MY SON WHEN HE WAS 3-1/2. HE TOLD THEM THAT HE WAS SET UP. HE TOLD THEM THAT I WAS. AND THEY WOULDN'T LISTEN. THEY TOTALLY IGNORED HIM. I HAVE NOT SEEN HIM IN SIX MONTHS OR TALKED TO THEM IN SIX MONTHS DUE TO AN ABUSIVE LETTER I'VE GIVEN THIS GUY RIGHT HERE. I'VE GIVEN YOU GUYS COPIES OF IT IT. I JUST CANNOT EXPRESS HOW DISGUSTED I AM. 

SUP. MOLINA: THANK YOU. NEXT WE HAVE . MARCO REYES MR. REYES? 

MARCO REYES: GOOD MORNING TO THE BOARD. 

SUP. MOLINA: GOOD MORNING. 

MARCO REYES: I WAS A CONTRACT EMPLOYEE FOR DISTRICT 7. AND I SAW A LOT OF INJUSTICES THROUGH DISTRICT 7 AND DISTRICT 31. THIS IS REGARDING COLOR. MOST OF THE ADMINISTRATION IS AFRICAN-AMERICAN. AND I SAW A LOT OF IT-- 

SUP. MOLINA: WE CAN BARELY HEAR YOU. THANK YOU. 

MARCO REYES: I SAW A LOT OF INJUSTICES TOWARDS HISPANICS AND THE ASIANS OVER THERE IN DISTRICT 31 AND 7. A LOT OF MY SUPERVISORS, HISPANIC SUPERVISORS AND ALL OF THAT WERE LIKE REALLY, REALLY BEING TREATED UNJUSTLY. BEFORE, LIKE I SAY, I USED TO HAVE LIKE A HISPANIC DEPUTY WHO WOULD LOOK OUT FOR EVERYONE, BUT SHE RETIRED. AND AFTER THAT, IT HAS JUST BEEN BAD. SO I JUST WANT TO SEE IF THE BOARD WOULD TAKE THE TIME AND REVIEW ALL OF THIS, ALL OF THESE ADMINISTRATORS TO SEE IF THEY ARE PROPERLY EDUCATED, TO SEE WHAT'S WRONG WITH THEM BECAUSE EVERYTHING, IT'S REALLY UNJUST. ONE OF THE MAIN THINGS THAT BROUGHT TO OUR ATTENTION WAS HOW THEY HAD A BLACK HISTORY MONTH. AND YET WHEN THE CINCO DE MAYO CAME AROUND, IT WAS NOT CELEBRATED AND IT WAS APPROVED BY OUR ADMINISTRATION IN DISTRICT 7. SO THAT'S SOMETHING THAT REALLY BRINGS IT UP TO MY ATTENTION. I FEEL LIKE A LOT OF PEOPLE COMPLAIN, BUT THEY'RE SCARED. THEY'RE SCARED TO COME OVER HERE TO THE BOARD OR THEY JUST DON'T KNOW, AND NOTHING MUCH CAN BE DONE. SO I WAS HOPING THE BOARD WOULD TAKE INTO CONSIDERATION IN GOING TO DISTRICT 7 AND 31 AND SEE WHAT'S GOING ON OVER THERE. THE ADMINISTRATOR'S NAME IS BRENDA MCINTYRE, CAROL MASTON. I DON'T KNOW. THIS MIGHT BE PRIVACY LAWS. CAROL MASTON. AND THE ADMINISTRATORS ON BOTH DISTRICTS. SO I HOPE YOU WOULD REALLY TAKE IT INTO CONSIDERATION. IF NOT, I'M PRETTY SURE [INAUDIBLE] THAT'S IT. 

SUP. MOLINA: OKAY. THANK YOU. DISTRICTS 7 OF WHAT? I'M SORRY. 

MARCO REYES: DEPARTMENT OF SOCIAL SERVICES, MA'AM. 

SUP. MOLINA: VERY GOOD. THANK YOU. 

MARCO REYES: 31, TOO, MA'AM. THANK YOU. 

SUP. MOLINA: THANK YOU. ALL RIGHT. THAT CONCLUDES ALL OF THE ITEMS BEFORE US. UNLESS THERE IS ANY OTHER ISSUES, THEN WE ARE ADJOURNED. THANK YOU. OH, THAT'S RIGHT. WE HAVE CLOSED SESSION. 

DON ASHTON: MADAME CHAIR, IN ACCORDANCE WITH BROWN ACT REQUIREMENTS, NOTICE IS HEREBY GIVEN THAT THE BOARD OF SUPERVISORS WILL CONVENE IN CLOSED SESSION TO DISCUSS ITEM NO. C.S.-1, CONFERENCE WITH LEGAL COUNSEL REGARDING SIGNIFICANT EXPOSURE TO LITIGATION, ONE CASE, AS INDICATED ON THE SUPPLEMENTAL AGENDA. THANK YOU. 
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